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INTRODUCTIONINTRODUCTION

Tell me and I forget. Teach me and I remember. Involve me and I learn. 

—Benjamin Franklin 

Live Wire is an interactive course in computer science, based on Windows 10 and Microsoft 
Office 2019, designed for classes 1 to 8. The course follows a practice-oriented approach and 
includes the latest developments in technology.

The curriculum introduces the concepts of Coding and Artificial Intelligence at Foundational 
Stage to foster essential skills for problem-solving, digital literacy, creativity, and knowledge to 
thrive in a technology-driven world. The series includes the latest innovations in technology 
like Robotics, IoT, Smart Homes, NLP, Data Science, Cloud Computing, Web Development, and 
Cyber Security. The course design introduces learners to the latest software applications at 
appropriate grades to ensure they are future ready. Evaluation and assessment are conducted 
through objective, subjective, and application-based questions. Apart from these, there are 
lab activities and project work for learning through hands-on experiences.

Live Wire explains the tools and techniques related to computer science through real-life 
contexts. At the same time, it touches upon the flip side of using the internet and social 
networking sites. The course aims at making learners vigilant and encourages them use 
technology in a fruitful way. This series encourages the learners to gain confidence in expressing 
themselves in various languages, while also developing a deep appreciation for the cultural 
diversity of India. Along with higher order thinking skills, the books also incorporate various 
educational games that are interesting to attempt and at the same time enhance the child’s 
reasoning abilities too. Moreover, the course aligns with several Sustainable Development 
Goals (SDGs) to foster a holistic learning experience.

The lesson plans have been planned and written in a manner that shows how a chapter 
can be easily taught through various hands-on activities. These activities encourage learner 
participation, facilitate the comprehension of related concepts, and induce learners to think 
analytically and critically. Learners are exposed to varied ways of learning so that effective 
learning takes place. As a result, learners develop an active interest in learning without being 
forced to learn.



A TEACHER’S ROLE IN  A TEACHER’S ROLE IN  
CLASSROOM: SOME GUIDELINESCLASSROOM: SOME GUIDELINES

The NCF 2023 has several roles and responsibilities for teachers:
•	 Planning: Teachers plan, prepare, and teach programs to achieve specific student 

outcomes.
•	 Pedagogy: Teachers develop pedagogical strategies to encourage active learning, student-

centered teaching, and interactive instruction.
•	 Learning environment: Teachers identify differences in students' abilities, interests, and 

needs to provide a personalized learning environment.
•	 Assessment: Teachers use a variety of assessment principles, including observing student 

behavior, having students create concept maps, objective type questions, constructed 
response questions, oral and practical assessments.

•	 Activities: Teachers develop activities that can help students achieve descriptive and 
procedural knowledge. These activities can include—Integration of subjects, Group work, 
and Webinars.

•	 Encourage Expression: Teachers encourage the use of regional/ local languages as the 
language of instruction in the classroom. Also, they encourage the use of mother tongue 
or any other language that the student is familiar with, in the classroom as a medium of 
expression/ explanation.

Based on the unique approach followed in Live Wire, teachers may follow these guidelines to 
ensure optimum use of the course for the benefit of learners.

•	 Encourage the use of mother tongue, or regional languages, or any other language that 
the student is familiar with, in the classroom as a medium of verbal expression for the 
Let’s Talk and Let’s Discuss activities given in the coursebook.

•	 Emphasise on the tools and the concept behind them. 
•	 Help learners explore the tools on their own. 
•	 Build the concepts slowly and steadily through real-life examples given in the textbook.
•	 Take some related examples, especially from other subjects, such as maths, EVS/science, 

social studies, and English, wherever possible. 
•	 Ensure that the classroom environment remains engaging, conducive to learning, and 

lively.



TEACHER’S RESOURCE KIT (TRK)TEACHER’S RESOURCE KIT (TRK)

Indiannica Learning provides the below mentioned support to the teachers along with the Live 
Wire coursebooks:

•	 Digibooks: Digital audio-visual books for paperless learning experience. It includes 
animated videos for all topics and interactive exercises along with a number of other 
features.

•	 Teacher’s Manual: Detailed lesson plans with well-defined theory and practical sessions. 
It also includes solutions to the assessment questions.

•	 Animated Videos: Each topic has been explained through videos in order to make the 
learning process more interesting and engaging.

•	 Interactive Exercises: The chapter-end exercises can also be discussed digitally in the 
classroom making the assessment process more competitive. 

•	 Worksheet Solutions: Solved worksheets are provided to get easy access to the answers.
•	 Test Paper Generator: An extremely helpful tool to create test papers according to the 

teacher’s requirements. The solutions to the test papers can also be generated. 

Implementing NEP 2020 and NCF 2023
The National Curriculum Framework (NCF) is developed based on the vision of the National 
Education Policy (NEP) 2020, and to enable its implementation. Live Wire Teacher’s Manual 
facilitates the implementation of the Vision of NEP 2020 and the objectives of NCF 2023.

Aims of Education Curricular Goals Competencies Learning Outcomes

Scan the QR to find the list of Curricular Goals and 
the Competencies for each of the Curricular Goals as 

listed in the NCF 2023.

Scan the QR to find the list of Sustainable Development 
Goals (SDGs) as adopted by the Department of 

Economic and Social Affairs, United Nations



CONTENTSCONTENTS

Note

CG stands for Curricular Goals and C stands for competency. The Curricular Goals have been listed in the NCF 2023 
document. The Competencies have been highlighted across the lesson plans.

Chapters Page No.
Period Distribution

Theory Practical TOTAL

Chapter 1
Computer – Types and 
Devices

1 5 1 6

Chapter 2 Memory and Storage Devices 5 5 1 6

Chapter 3 Exploring Windows 10 9 5 4 9

Chapter 4
Working with Objects in 
Word

14 5 4 9

Chapter 5 Exploring Word 19 5 4 9

Worksheet 1 24 2 – 2

Chapter 6 AI – Internet of Things (IoT) 26 4 1 5

Chapter 7 PowerPoint: An Introduction 30 4 5 9

Chapter 8 Scratch Coding and Games 37 4 5 9

Chapter 9 The Internet 43 4 2 6

Worksheet 2 47 2 – 2

Project Work – – 2

Annexure Office 365 - A Glimpse – – 1

Total Number of Periods 43 28 74
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COMPUTER–TYPES AND DEVICES

LEARNING OUTCOMES
After going through this chapter, the students will be able to:  

	! Learn about different types of computers using effective methods of communication.
	! Understand the role of input devices, processing device, and output devices in a formal learning classroom environment.
	! �Learn about the data and control flow in detail along with the advantages and limitations of a computer through 

observation and logical thinking.

LESSON PLAN 1 3 Periods

Topics covered in this lesson plan:						    
•	 Types of Computers							       Theory – 3 Periods
•	 Input Devices
•	 Processing Device
•	 Data and Control Flow

LEARNING OBJECTIVES
By the end of this lesson, students will be able to:

	! understand different types of computers.
	! locate input devices and processing device.
	! explain the components of the CPU and their functions.
	! briefly describe the data and control flow in a computer system.

WARM UP
2.4.2.1: CG-1 Sustain effective communication skills for enhancing their oral abilities.

Ask following questions to the students and listen to their answers to understand the children’s mindset.
•	 What kind of computer do you use at home?
•	 What type of computer do you think you parents use at their workplace?
•	 Is there any difference between the computers you use at home and the computers your parents use at their workplace?
	 1.	Before starting the chapter, guide the students to solve the exercise given in the Let’s Check-In section on page 7 of 

the textbook.

CURRICULAR GOALS
2.4.1.1: CG-1 Students develop oral language skills using complex sentence 
structures to understand and communicate abstract ideas.
2.4.2.1: CG-1 Sustains effective communication skills for day-to-day interactions, 
enhancing their oral ability to express ideas.
7.4.2.1: CG-4 Develops sensitivity towards social and natural environment.
8.5.1.1: CG-2 Develops an awareness of their personal and social behaviour 
towards themselves and others.

Topics No. of 
Periods

•	 Types of Computers
•	 Input Devices
•	 Processing Device
•	 Data and Control Flow

3

•	 Output Devices
•	 Advantages of a Computer
•	 Limitations of a Computer

3

1
TOTAL PERIODS: 6
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	 2.	Explain the students that a computer has been the most important invention created by human beings.
	 3.	Tell the students that a computer is divided into different categories based on their size, cost, and speed.
	 4.	Share the details of Personal Computer (PC), Mainframe, Server, and Supercomputer with the students for the better 

understanding of their roles.
	 5.	The students may read the additional information provided on the link given in the Let’s Read section of this 

chapter.
	 6.	Help the students to complete the activity given in Milestone on page 8 of the textbook as per the instructions.

1. Supercomputer			   2. Mainframe			   3. Personal Computer

Answer

	 7.	Play the animated video on the topic Types of Computers provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 8.	Tell them what an input device is along with some advanced input devices like Touchpad, Graphics Tablet, Biometric 
Devices, Barcode Reader, Digital Camera, OCR, OMR, and MICR.

	 9.	Explain the role of all these input devices in detail to the students.
	 10.	Play the animated video on the topic Input Devices provided in the Teacher’s Resource Kit to reinforce the concepts.

	 11.	Encourage the students to talk and share their thoughts about the topic given in the Let’s Talk section on page 10 
of the textbook. Motivate the use of mother tongue (if possible), otherwise let the child use any language or the 
language of instruction of the class.

7.4.2.1: CG-4 Develops sensitivity towards social and natural environment.

8.5.1.1: CG-2 Develops an awareness of personal and social behaviour towards themselves and others.
	 12.	Encourage the students to do the activity given in the SDG section on page 16 of the textbook. Motivate them to 

practice sustainability to achieve a better future for all. 
		 Note: Students can also perform this activity at home under the guidance of their parents.

•	 Explain the steps to be followed as per the activity given in the textbook.
•	 Ask the students to share their experience in the next period.

	 13.	Tell them about the processing device, i.e., CPU. Define the working and all the components of a CPU in brief.
	 14.	Define how the data and control flows in a computer through various components of CPU.
	 15.	Use the labelled block diagram and explain each step with the students.

	 16.	Play the animated video on the topic Processing Device and Data and Control Flow provided in the Teacher’s 
Resource Kit to reinforce the concepts.

2.4.1.1: CG-1 Students develop oral language skills using complex sentence structures to understand and communicate 
abstract ideas.
	 17.	Ask the students to perform the activity given in the Let’s Discuss section on page 12 of the textbook. Motivate the use 

of any language the students are comfortable with, otherwise let them use the language of instruction of the class.
•	 Divide the class in groups and ask each group to discuss as given in the textbook.
•	 Make sure all the students perform the activity.

Closure
Make sure all the students understand data and control flow.

1.	 Write the names of different types of computers.
2.	 What is the full form of ALU?

Assessment for Learners
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LESSON PLAN 2 3 Periods

Topics covered in this lesson plan:						    
•	 Output Devices							       Theory – 2 Periods
•	 Advantages of a Computer					     	 Practical – 1 Period
•	 Limitations of a Computer

LEARNING OBJECTIVES
By the end of this lesson, students will be able to:

	! explain the output devices with their functions.
	! define advantages of a computer in detail.
	! explain the limitations of using a computer.

WARM UP

2.4.2.1: CG-1 Sustain effective communication skills for enhancing their oral abilities.

Revise the topics taught in the previous lesson plan to the students. Ask them if they have any query.
	 1.	Discuss in detail the meaning of output devices with some common examples.
	 2.	Define the role of the advanced output devices taught in the chapter like, Plotter, Speech Generating Device, Braille 

Reader, etc.
	 3.	Help the students to complete the activity given in Milestone on page 13 of the textbook as per the instructions.

	 1.	 Graphics tablet	 	 2.	 OCR	

	 3.	 Touchpad	 	 4.	 Braille reader	

	 5.	 Plotter	 	 6.	 SGD	

I I

I O

O O

Answer

	 4.	Play the animated video on the topic Output Devices provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 5.	Define the advantages of a computer to the students with the help of some common daily life examples.
	 6.	Explain the limitations of using a computer in detail to the students for their better understanding of the topic.

	 7.	Play the animated video on the topic Advantages and Limitations of a Computer provided in the Teacher’s 
Resource Kit to reinforce the concepts.

	 8.	Summarise the important topics to the class given in the Now I Know section on page 14 of the textbook.
	 9.	Discuss the chapter-end exercises given in the Assessment Time section on page 14 and 15 of the textbook. Assist 

students to write the answers in their notebook. 
		 Note: Answers are provided at the end of this Lesson Plan.
	 10.	Discuss the questions given in the Application based questions and Competency based questions on page 15 of the 

textbook. Ask the students to relate to the situation as a real-life incident and think about the solution. Help them 
write the answers in the notebook.

	 11.	Discuss the HOTS question given in the Think and Answer section on page 16 of the textbook. Help the students to 
write the answer in their notebook.
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Closure
Draw a comparison between input and output devices. Ask students to note down the points in their exercise books.

1.	 What is the function of a braille reader?
2.	 Share any two advantages of a computer.

Assessment for Learners

Assist the students and let them perform the following activity in the computer lab as given in the Hands on Computer 
section on page 16 of the textbook.
	 1.	 Take the students to the computer lab and divide the class into five groups.
	 2.	 Guide the students in performing all the instructions given under instructions 1 to 5.
	 3.	 Help them in completing the activity. Make sure they understand how to do this activity.

Practical Session – 1 Period

A.	 Tick the correct option. 
	 1. d. Server	 2. a. ALU	 3. d. Plotter	 4. a. Touchpad	 5. b. MICR 
B.	 Fill in the blanks.
	 1. Input	 2. MU	 3. Graphics 	 4. Mark	 5. PC
C.	 Write T for true and F for false.
	 1.	 T		  2. F	 3. F	 4. T	 5. T
D.	 Answer the following.
	 1.	� MICR stands for Magnetic Ink Character Reader. It is used to read special characters printed in magnetic ink. 

It is used by the banking system to read numbers on the bottom of the cheques. These numbers are printed 
using a specific type of ink that contains particles of magnetic material.

	 2.	 Face scanner and Fingerprint scanner.
	 3.	 Three components of CPU are: Arithmetic Logic Unit (ALU), Memory Unit (MU), and Control Unit (CU).
	 4.	 The data flows as the following:

•	 �Input device sends the control signals and data to the computer which then goes to the main memory of 
the computer.

•	 �Central Processing Unit (CPU) fetches the data from the main memory and performs arithmetic and 
logical operations as per the instructions, and stores the result in the main memory.

•	 �Storage Unit is used to store the processed data permanently for future use. The data stored in this unit 
cannot be accessed directly by the ALU for processing. The data is first loaded to the primary memory, 
then it can be used for processing.

•	 �Output device receives the processed data from main memory & display an output of completed process.
	 5.	 A plotter is used to makes line drawings with ink pens on a sheet of paper.
E.	 Application based questions.
	 Answer may vary from student to student.
F.	 Competency based questions.
	 Answer may vary from student to student.

Assessment Time Page 14Answers
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MEMORY AND STORAGE DEVICES

LEARNING OUTCOMES
After going through this chapter, the students will be able to:  

	! Learn about computer memory and it is made up of bits & bytes in detail using effective methods of communication.
	! Understand what is inside a computer and role of each component in a formal learning classroom environment.
	! �Learn computer memory and its sub-division which are primary and secondary memory though observation and logical 

thinking.

LESSON PLAN 1 2 Periods

Topics covered in this lesson plan:						    
•	 Bits and Bytes							       Theory – 2 Periods
•	 Inside the Computer

LEARNING OBJECTIVES
By the end of this lesson, students will be able to:

	! define bits and bytes.
	! explain about the components inside a computer.

WARM UP
2.4.2.1: CG-1 Sustain effective communication skills for enhancing their oral abilities.
Divide the class into four groups. Ask the students to share the things that they use to store things at home and school with  
the group. Let the groups discuss and share with the class.
	 1.	Before starting the chapter, guide the students to solve the exercise given in the Let’s Check-In section on page 17 

of the textbook.
	 2.	 Introduce the students with the concept of computer memory in detail for better understanding of the further topics.
	 3.	Define the meaning of bits and bytes to the students.
	 4.	Explain the role of bits bytes with help of the table given on page 17 of the textbook.

	 5.	Play the animated video on the topic Bits and Bytes provided in the Teacher’s Resource Kit to reinforce the 
concepts.

7.4.2.1: CG-4 Develops sensitivity towards social and natural environment.
	 6.	Encourage the students to do the activity given in the SDG section on page 25 of the textbook. Motivate them to 

practice sustainability to achieve a better future for all. 

CURRICULAR GOALS
2.4.1.1: CG-1 Students develop oral language skills using complex sentence 
structures to understand and communicate abstract ideas.
2.4.2.1: CG-1 Sustains effective communication skills for day-to-day interactions, 
enhancing their oral ability to express ideas.
7.4.2.1: CG-4 Develops sensitivity towards social and natural environment.

Topics No. of 
Periods

•	 Bits and Bytes
•	 Inside the Computer 2

•	 Computer Memory
•	 Primary Memory
•	 Secondary Memory

4

2
TOTAL PERIODS: 6
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		 Note: Students can also perform this activity at home under the guidance of their parents.
•	 Explain the steps to be followed as per the activity given in the textbook.
•	 Ask the students to share their experience in the next period.

	 7.	Tell the students that there is a motherboard inside a computer.
	 8.	Share with the students that it contains silicon chips which make up the entire electronic circuit.
	 9.	Explain the role of PCB along with its full form with the students. 
	 10.	Show the labelled image given on page 18 of the textbook to the students for better understanding of the topic.

	 11.	Play the animated video on the topic Inside a Computer provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 12.	Help the students to complete the activity given in Milestone on page 18 of the textbook as per the instructions.

1. (iii) 1 Kilobytes	 2. (v) 1024 Terabytes	 3. (i) 1 Byte	 4. (ii) 1 Gigabytes	 5. (iv) 1024 Gigabytes

Answer

Closure
Tell the students to learn the bits and bytes table as given on page 17 of the textbook.

1.	 What is a nibble?
2.	 Define PCB.

Assessment for Learners

LESSON PLAN 2 4 Periods

Topics covered in this lesson plan:						    
•	 Computer Memory							       Theory – 3 Periods
•	 Primary Memory							       Practical – 1 Period
•	 Secondary Memory

LEARNING OBJECTIVES
By the end of this lesson, students will be able to:

	! learn about computer memory in detail.
	! define primary memory with its types.
	! define secondary memory with its types.

WARM UP
2.4.2.1: CG-1 Sustain effective communication skills for enhancing their oral abilities.
Ask students to write the memorised bytes table in their notebook correctly. Make sure they know it.
	 1.	Revise the topics to the students which are taught in the previous class.
	 2.	Tell the students about computer memory in brief.
	 3.	Explain to the students that there are two types of memory – Primary and Secondary with the help of hierarchy chart 

given on page 19 of the textbook.
	 4.	Play the animated video on the topic Computer Memory provided in the Teacher’s Resource Kit to reinforce the 

concepts.
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	 5.	Define primary memory to the students and tell them that there are two types of primary memory – RAM and ROM.
	 6.	Explain the role of RAM and ROM in detail to the students.
	 7.	Share the types of ROM with the students for better understanding of the topic.
	 8.	Define the meaning of volatile and non-volatile to the students for better understanding of the topic.
	 9.	The students may read the additional information provided on the link given in the Let’s Read section of this 

chapter.
2.4.1.1: CG-1 Students develop oral language skills using complex sentence structures to understand and communicate 
abstract ideas.
	 10.	Ask the students to perform the activity given in Let’s Discuss section on page 20 of the textbook. Motivate the use 

of any language the students are comfortable with, otherwise let them use the language of instruction of the class.
•	 Divide the class in groups of three students.
•	 Ask the students to discuss about importance of RAM and ROM.

	 11.	Play the animated video on the topic Primary Memory provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 12.	Explain secondary memory to the students in detail and define its role.
	 13.	Define hard disk and its role in computer memory in detail to the students.
	 14.	Share the information about CD, DVD, Blu-ray Disc, Pen drive, and Memory card in detail with the students.
	 15.	Encourage the students to talk and share their thoughts about the topic given in the Let’s Talk section on page 22 

of the textbook. Motivate the use of mother tongue (if possible), otherwise let the child use any language or the 
language of instruction of the class.

	 16.	Explain about the evolution of storage device over the years as given in the Time Travel section on page 22 of the 
textbook.

	 17.	Help the students to complete the activity given in Milestone on page 23 of the textbook as per the instructions.

1. Bit		  2. Primary memory		  3. ROM		  4. Hard disk		  5. Memory card

Answer

	 18.	Play the animated video on the topic Secondary Memory provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 19.	Summarise the important topics to the class given in the Now I Know section on page 23 of the textbook.
	 20.	Discuss the chapter-end exercises given in the Assessment Time section on page 23 and 24 of the textbook. Assist 

students to write the answers in their notebook. 
		 Note: Answers are provided at the end of this Lesson Plan.
	 21.	Discuss the questions given in the Application based questions and Competency based questions on page 24 and 25 

of the textbook. Ask the students to relate to the situation as a real-life incident and think about the solution. Help 
them write the answers in the notebook.

	 22.	Discuss the HOTS question given in the Think and Answer section on page 25 of the textbook. Help the students to 
write the answer in their notebook.

Closure
Ensure that the students are now familiar with the concepts of primary memory and secondary memory.

1.	 What is the meaning of volatile nature?
2.	 What is the full form of CD and DVD?

Assessment for Learners
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Assist the students and let them perform the following activity in the computer lab as given in the Hands on Computer 
section on page 25 of the textbook.
	 1.	 Take the students to the computer lab and divide the class into five groups.
	 2.	 Guide the students in performing as per the instructions given.
	 3.	 Help them in completing the activity.
	 4.	 Make sure they understand how to do this activity.

Practical Session – 1 Period

A.	 Tick the correct option. 
	 1.	 b. 1024 KB	 2. a. RAM	 3. d. EPROM	 4. c. DVD	 5. b. Memory Card
B.	 Fill in the blanks.
	 1.	 1024	 2. Byte	 3. Primary and Secondary	 4. Random 
	 5. Hard Disk
C.	 Write T for true and F for false.
	 1.	 T		  2. F	 3. T	 4. F 	 5. T
D.	 Answer the following questions.
	 1.	 A sequence of 8 bits is called a byte.
	 2.	� A motherboard is a big PCB that is the main circuit board inside a computer. It holds the most important parts, 

like the CPU, memory, and other essential components. It is like the central hub that connects everything in 
the computer so that it can work together smoothly.

	 3.	� The primary memory, also known as the internal memory, is the main memory of the computer. It stores the 
programs and data that are currently being run by the CPU. It is an integral part of a computer system. It is 
very fast and located on the motherboard. It cannot store large amount of data. There are two types of primary 
memory—RAM and ROM.

	 4.	� CD, DVD, and Blu-Ray Disc.
	 5.	� The secondary memory stores data permanently until a user deletes it. Since it is not possible to store data in 

the primary memory, it is important to have secondary memory in the computer. The secondary memory is 
also known as the external memory or the auxiliary memory. All our data in the form of files are stored in this 
memory.

E.	 Application based questions.
	 Answer may vary from student to student.
F.	 Competency based questions.
	 Answer may vary from student to student.

Assessment Time Page 23Answers
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EXPLORING WINDOWS 10

LEARNING OUTCOMES
After going through this chapter, the students will be able to:  

	! Learn about different methods for arranging Windows using sensorial perception and observational skills.
	! �Understand about the accessories and file explorer with their functions provided by Windows through logical thinking 

and observation.
	! �Learn about file/folder, its types, and all the operation that can be performed on them in a formal learning classroom 

environment.

LESSON PLAN 1 4 Periods

Topics covered in this lesson plan:						    
•	 Arranging Windows							       Theory – 2 Periods
•	 Windows Accessories						      Practical – 2 Periods
•	 File Explorer

LEARNING OBJECTIVES
By the end of this lesson, students will be able to:

	! arrange multiple opened Windows using different methods.
	! understand and learn the role of various Windows accessories.
	! learn about File Explorer and its components.

WARM UP
2.4.2.1: CG-1 Sustain effective communication skills for enhancing their oral abilities.
Take students to the computer lab and tell them to Switch On the computer. Ask them to identify the basic components of 
desktop as taught in the previous class.
	 1.	Before starting the chapter, guide the students to solve the exercise given in the Let’s Check-In section on page 26 

of the textbook.
	 2.	Revise the topics with students about Desktop and its components in brief for better understanding.
	 3.	Tell the students that they can arrange the opened Windows while working with multiple applications using different 

methods.

CURRICULAR GOALS
2.4.1.1: CG-1 Students develop oral language skills using complex sentence 
structures to understand and communicate abstract ideas.
2.4.2.1: CG-1 Sustains effective communication skills for day-to-day interactions, 
enhancing their oral ability to express ideas.
7.4.2.1: CG-4 Develops sensitivity towards social and natural environment.

Topics No. of 
Periods

•	 Arranging Windows
•	 Windows Accessories
•	 File Explorer

4

•	 File/Folder
•	 Types of Files
•	 Working with Files and 

Folders
•	 Transferring Data
•	 Creating Shortcuts

5

3
TOTAL PERIODS: 9
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	 4.	Demonstrate the different methods of arranging Windows to the students which are as follows:
		  a. Cascade Windows
		 b. Show Windows Stacked
		  c. Show Windows Side by Side
	 5.	Tell the students that they can also remove the changes applied using proper methods.
	 6.	Describe the role of Snap feature using the detailed steps to the students.
2.4.1.1: CG-1 Students develop oral language skills using complex sentence structures to understand and communicate 
abstract ideas.

	 7.	Ask the students to perform the activity given in Let’s Discuss section on page 29 of the textbook. Motivate the use 
of any language the students are comfortable with, otherwise let them use the language of instruction of the class.
•	 Divide the class in groups of three students.
•	 Ask the students to discuss how things are organised.

	 8.	Play the animated video on the topic Arranging Windows provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 9.	Tell the students that there are some applications provided by Windows which are found in Windows Accessories.
	 10.	Demonstrate the method for accessing theses accessories using the given steps.
	 11.	Tell them about the following Windows Accessories and their function:
		  a. Notepad			   b. Paint				   c. Snipping Tool
		 d. WordPad			   e. Step Recorder			   f. Quick Assist

	 12.	Play the animated video on the topic Windows Accessories provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 13.	Define what is a File Explorer to the students in brief. 
	 14.	Demonstrate the detailed steps to open File Explorer along with its components as given in the textbook.
	 15.	Explain about the evolution of file explorer icon with Windows as given in the Time Travel section on page 30 of 

the textbook.
	 16.	Explain all the components of File Explorer to the students using the labelled screenshot given in the textbook.

	 17.	Play the animated video on the topic File Explorer provided in the Teacher’s Resource Kit to reinforce the concepts.
7.4.2.1: CG-4 Develops sensitivity towards social and natural environment.
	 18.	Encourage the students to do the activity given in the SDG section on page 40 of the textbook. Motivate them to 

practice sustainability to achieve a better future for all. 
		 Note: Students can also perform this activity at home under the guidance of their parents.

•	 Ask the students to bring the material required for the activity.
•	 Demonstrate the steps by following the instructions given in the textbook.

Closure
Ask the students to observe and identify all the components of file explorer.

1.	 What is the role of Quick Assist?
2.	 What is File Explorer?

Assessment for Learners
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Practical 1
Guide the students to do the activities in the lab as per the given instructions. 
	 1.	 Let the students learn the concepts of arranging Windows and snap feature by practically applying the same 

as given on pages 26 to 29 of the textbook.
	 2.	 Let the students learn the concepts of Windows Accessories and their functions as given on pages 29 and 30 

of the textbook.
	 3.	 Let the students learn the concept of File Explorer and its components by practically applying the steps as 

given on pages 30 and 31 of the textbook.
Practical 2
Guide the students to perform the activities given in the Hands on Computer section on page 39 of the textbook.
	 1.	 Take the students to the computer lab and divide the class into five groups.
	 2.	 Guide the students in completing the activity and perform all the instructions given under activity A.
	 3.	 Help the students in performing all the operations on their own.

Practical Session – 2 Periods

LESSON PLAN 2 5 Periods

Topics covered in this lesson plan:						    
•	 File/Folder								        Theory – 3 Periods
•	 Types of Files							       Practical – 2 Periods
•	 Working with Files and Folders
•	 Transferring Data
•	 Creating Shortcuts

LEARNING OBJECTIVES
By the end of this lesson, students will be able to:

	! learn about file/folder and types of files.
	! perform different operations of files and folders.
	! learn to transfer data.
	! create shortcuts of different files/folders.

WARM UP
2.4.2.1: CG-1: Sustain effective communication skills for enhancing their oral abilities.
Ask the students if they have any doubts in the topics taught in the previous period. Clarify their doubts and demonstrate 
the steps if necessary.
	 1.	Define the meaning of file and folder to the students in detail with the help of suitable examples.
	 2.	Share the meaning of subfolder with the students.

	 3.	Play the animated video on the topic File or Folder provided in the Teacher’s Resource Kit to reinforce the concepts.
	 4.	The students may read the additional information provided on the link given in the Let’s Read section of this 

chapter.
	 5.	Tell the students that there are various types of files and a file name consists of two parts – File name and File 

extension.
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	 6.	 Introduce the concept of file extensions with the students using the simple examples.
	 7.	Share the list of commonly used file formats with the students along with the application names which uses these 

extensions.
	 8.	Play the animated video on the topic Types of Files provided in the Teacher’s Resource Kit to reinforce the concepts.

	 9.	Define all the operations that can be performed on files and folders using File Explorer.
	 10.	Demonstrate the steps for doing the following operations on a file/folder:
		  a.	 Copying a File/Folder			   b.  Moving a File/Folder
		  c.	 Renaming a File/Folder			   d.  Deleting a File/Folder
		  e.	 Restoring a File/Folder 

	 11.	Play the animated video on the topic Working with Files and Folders provided in the Teacher’s Resource Kit to 
reinforce the concepts.

	 12.	Tell the students that they can transfer data from one file/folder to another.
	 13.	Explain the concept of Drives to the students with the help of examples for better understanding of the topic.
	 14.	Elaborate the detailed steps for transferring the data to the students.

	 15.	Play the animated video on the topic Transferring Data provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 16.	Define the meaning of Shortcut to the students along with its purpose.
	 17.	Demonstrate the steps for creating a shortcut to the students.

	 18.	Play the animated video on the topic Creating Shortcuts provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 19.	Encourage the students to talk and share their thoughts about creating shortcut as per the instruction given in the 
Let’s Talk section on page 37 of the textbook. Motivate the use of mother tongue (if possible), otherwise let the child 
use any language or the language of instruction of the class.

	 20.	Summarise the important topics to the class given in the Now I Know section on page 37 of the textbook.
	 21.	Discuss the chapter-end exercises given in the Assessment Time section on page 38 and 39 of the textbook. Assist 

students to write the answers in their notebook. 
		 Note: Answers are provided at the end of this Lesson Plan.
	 22.	Discuss the questions given in the Application based questions and Competency based questions on page 39 of the 

textbook. Ask the students to relate to the situation as a real-life incident and think about the solution. Help them 
write the answers in the notebook.

	 23.	Discuss the HOTS question given in the Think and Answer section on page 40 of the textbook. Help the students to 
write the answer in their notebook.

Closure
Ask the students to create shortcuts of different files that they have created.

1. What is a shortcut?			   2. What is a drive?

Assessment for Learners

Practical 1
Guide the students to do the activities in the lab as per the given instructions. 
	 1.	 Let the students learn the all the operation that can be performed on files and folders by practically applying 

the steps as given on pages 33 to 35 of the textbook.

Practical Session – 2 Periods
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	 2.	 Let the students learn the concepts of transferring data by practically applying the steps as given on page 35 
and 36 of the textbook.

	 3.	 Let the students learn the concepts of creating shortcuts by practically applying the steps as given on page 36 
and 37 of the textbook.

Practical 2
Guide the students to perform the activities given in the Hands on Computer section on page 40 of the textbook.
	 1.	 Take the students to the computer lab and divide the class into five groups.
	 2.	 Guide the students in completing the activity and perform all the instructions given under activity B.
	 3.	 Help the students in performing all the operations on their own.

A.	 Tick the correct option. 
	 1.	 a. Snipping tool	 2. d. File List pane	 3. b. .mp3 	 4. c. Recycle Bin	 5. d. Ctrl+X
B.	 Write T for true and F for false.
	 1. T		  2. T	 3. T	 4. F	 5. T
C.	 Match the following.
	 1. d. Image	 2. a. Audio	 3. e. Video	 4. c. Document 
	 5. b. Compressed files
D.	 Answer the following.
	 1.	� WordPad is a basic word-processing application that lets you create and edit documents. It also provides tools 

to format text and insert images. Whereas, Notepad is a program that is used to create simple text files. It is 
not possible to format text or add images in Notepad.

	 2.	� File Explorer is a file manager application. It lets you to access, edit, manage, and organise your files and 
folders. You can use it to view, create, delete, copy, move, rename, and search files and folders.

	 3.	� File Extension represents the type of the file. It denotes the application which has been used to create the file. 
It also tells us in which application the file will be opened.

	 4.	 To delete a file/folder, follow these steps:
		  i.	 Select the file/folder you want to delete.
		  ii.	 From the Organize group in the Home tab, click on the Delete command. 
			   Or 
		  Press Delete key on the keyboard.
		  iii.	 The selected file/folder will be deleted and moved to the Recycle Bin.
	 5.	� A shortcut icon gives a quick and easy access to an application, a file, or a folder. A shortcut can be identified 

by a small, upward curved arrow on its icon. A shortcut icon is usually placed on the Desktop or at a place 
from where you can easily access it, and you do not need to search for it.

E.	 Application based questions.
	 Answer may vary from student to student.
F.	 Competency based questions.
	 Answer may vary from student to student.

Assessment Time Page 38Answers



Live Wire14

WORKING WITH OBJECTS IN WORD

LEARNING OUTCOMES
After going through this chapter, the students will be able to:  

	! Learn about adding a text box and inserting a WordArt through observation. 
	! Understand how to work with shapes, symbols, and pictures through logical thinking and sensorial perception.
	! Learn to crop a picture and add a screenshot in a formal learning classroom environment and observation.
	! Learn to add SmartArt graphics and a watermark for making the document look interesting.

LESSON PLAN 1 4 Periods

Topics covered in this lesson plan:						    
•	 Adding a Text Box						      Theory – 2 Periods
•	 Inserting a WordArt						      Practical – 2 Periods
•	 Working with Shapes
•	 Inserting Symbols

LEARNING OBJECTIVES
By the end of this lesson, students will be able to:

	! define how to add a text box in a Word document.
	! explain the steps for inserting a WordArt.
	! share how to work with and format shapes.
	! insert symbols in the Word document.

WARM UP
2.4.2.1: CG-1: Sustain effective communication skills for enhancing their oral abilities.

Ask following questions to the students and listen to their answers:
•	 Do you use different text style while working on notebooks?
•	 What kind of decorative things you use to make your project look interesting?
	 1.	Before starting the chapter, guide the students to solve the exercise given in the Let’s Check-In section on page 41 

of the textbook.

CURRICULAR GOALS
2.4.1.1: CG-1 Students develop oral language skills using complex sentence 
structures to understand and communicate abstract ideas.
2.4.2.1: CG-1 Sustains effective communication skills for day-to-day interactions, 
enhancing their oral ability to express ideas.
8.5.1.1: CG-2 Develops an awareness of their personal and social behaviour 
towards themselves and others.

Topics No. of 
Periods

•	 Adding a Text Box
•	 Inserting a WordArt
•	 Working with Shapes
•	 Inserting Symbols

4

•	 Inserting Pictures
•	 Cropping a Picture
•	 Adding a Screenshot
•	 SmartArt Graphic
•	 Adding a Watermark

5

4
TOTAL PERIODS: 9
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	 2.	Tell the students that Word lets you add various objects in the document for better understanding of the topic.
	 3.	Explain the role of Text Box to the students along with the steps for inserting in-built text box to the document.
	 4.	Share the steps for drawing a text box in a document with the students.

	 5.	Play the animated video on the topic Adding a Text Box provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 6.	Define WordArt to the students in detail for better understanding.
	 7.	Explain the elaborated steps for inserting a WordArt in a document to the students.

	 8.	Play the animated video on the topic Inserting a WordArt provided in the Teacher’s Resource Kit to reinforce the 
concepts.

8.5.1.1: CG-2 Develops an awareness of personal and social behaviour towards themselves and others. 
	 9.	Encourage the students to do the activity given in the SDG section on page 52 of the textbook.  Motivate them to 

practice sustainability to achieve a better future for all.
		 Note: Students can also perform this activity at home under the guidance of their parents.
		  •	 Ask the students to find out the ways to reuse and share things.
		  •	 Guide the students in raising awareness about recycling.
	 10.	Tell the students about Shapes in Word and its purpose.
	 11.	Demonstrate the steps for inserting and formatting a shape in Word as given in the textbook.

	 12.	Play the animated video on the topic Working with Shapes provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 13.	Tell the students that the symbols which are not found on the keyboard can be inserted from Symbols option 
provided in Word.

	 14.	Elaborate the steps for inserting the symbols in Word document to the students.
	 15.	Play the animated video on the topic Inserting Symbols provided in the Teacher’s Resource Kit to reinforce the concepts.

Closure
Ensure that the students understand how to use WordArt and Symbols in a Word document.

1.	 What is WordArt?
2.	 What is a text box?

Assessment for Learners

LESSON PLAN 2 5 Periods

Topics covered in this lesson plan:						    
•	 Inserting Pictures							       Theory – 3 Periods
•	 Cropping a Picture				    			   Practical – 2 Periods
•	 Adding a Screenshot
•	 SmartArt Graphic
•	 Adding a Watermark

LEARNING OBJECTIVES
By the end of this lesson, students will be able to:

	! demonstrate how to insert and format a picture.
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	! use cropping feature in Word.
	! explain the method for adding screenshot and SmartArt graphics.
	! define the purpose of a watermark in a document.

WARM UP
2.4.2.1: CG-1 Sustain effective communication skills for enhancing their oral abilities.

Before starting the period, ask if they have any doubts. Clarify them. Listen to their answers.
	 1.	Tell the students that they can insert a picture using multiple methods in a document.
	 2.	Demonstrate the steps for inserting a picture saved on the computer to the students.
	 3.	Explain the steps for inserting an online picture to the students.
	 4.	Encourage the students to talk about the importance of making the document beautiful and neat as given in the Let’s 

Talk section on page 45 of the textbook. Motivate the use of mother tongue (if possible), otherwise let the child use 
any language or the language of instruction of the class.

	 5.	Play the animated video on the topic Inserting Pictures provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 6.	Tell the students that they can crop a picture in Word.
	 7.	Demonstrate the steps for cropping a picture to the students as given in the textbook.

	 8.	Play the animated video on the topic Cropping a Picture provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 9.	Define the meaning of screenshot to the students for better understanding of the topic.
	 10.	Explain the steps for adding a screenshot in a Word document to the students.

	 11.	Play the animated video on the topic Adding a Screenshot provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 12.	Ask the students to complete the activity given in the Milestone section on page 46 of the textbook.

1.	 Inserting Pictures	 2. Adding a Screenshot	 3. Inserting Symbols	 4. Inserting Shapes

Answer

	 13.	 Introduce the concept of SmartArt to the students in detail for better understanding of the topic.

	 14.	Tell the students that they can add a SmartArt graphic to the Word document using the steps given in the textbook.

	 15.	 Inform the students that they can add or delete shapes in SmartArt using the steps given in the textbook.

	 16.	Demonstrate the steps for changing colour of the SmartArt graphic as given in the textbook.

	 17.	Play the animated video on the topic SmartArt provided in the Teacher’s Resource Kit to reinforce the concepts.

	 18.	Define the meaning and role of a watermark to the students in detail.

	 19.	Elaborate the steps for adding a watermark in a document to the students.

	 20.	Play the animated video on the topic Adding a Watermark provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 21.	The students may read the additional information provided on the link given in the Let’s Read section of this 
chapter.
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2.4.1.1: CG-1 Students develop oral language skills using complex sentence structures to understand and communicate 
abstract ideas.

	 22.	Ask the students to perform the activity given in Let’s Discuss section on page 49 of the textbook. Motivate the use 
of any language the students are comfortable with, otherwise let them use the language of instruction of the class.

		  •	 Divide the class in groups of five students.

		  •	 Ask each of these groups to discuss the importance of having a watermark.

	 23.	Summarise the important topics to the class given in the Now I Know section on page 49 of the textbook.

	 24.	Discuss the chapter-end exercises given in the Assessment Time section on page 50 and 51 of the textbook. Assist 
students to write the answers in their notebook. 

		 Note: Answers are provided at the end of this Lesson Plan.

	 25.	Discuss the questions given in the Application based questions and Competency based questions on page 51 of the 
textbook. Ask the students to relate to the situation as a real-life incident and think about the solution. Help them 
write the answers in the notebook.

	 26.	Discuss the HOTS question given in the Think and Answer section on page 52 of the textbook. Help the students to 
write the answer in their notebook.

Closure
Ensure that the students understand the concepts of watermark, SmartArt, and screenshot.

1.	 Write any one use of Watermark.
2.	 What is a SmartArt?

Assessment for Learners

Practical 1
Guide the students to do the activities in the lab as per the given instructions. 
	 1.	 Let the students learn to insert, crop, and format a picture by practically applying the steps given on page 44 

to 46 of the textbook.
	 2.	 Let the students learn to add a screenshot by practically applying the steps given on page 46 of the textbook.
	 3.	 Let the students learn to add SmartArt and Watermark by practically applying the steps given on page 47 to 

49 of the textbook.
	 4.	 Make sure the students learn how to perform all these operations and practice on their own. 
Practical 2
Guide the students to perform the activities given in the Hands on Computer section on page 51 and 52 of the textbook.
	 1.	 Take the students to the computer lab and divide the class into five groups.
	 2.	 Guide the students in creating a presentation as per the instructions given under activity A and B.
	 3.	 Help the students in completing the activity on their own.

Practical Session – 2 Periods



Live Wire18

A.	 Tick the correct option. 
	 1.	 b. Insert	 2. b. Crosshair	 3. d. Insert	 4. b. Illustration	 5. d. Watermark
B.	 Fill in the blanks.
	 1.	 Text box 	 2. WordArt	 3. Watermark	 4. Cropping	 5. Information
C.	 Write T for true and F for false.
	 1. T		  2. F	 3. T	 4. T	 5. F
D.	 Answer the following.
	 1.	 The steps to insert a built-in text box are as follows:
		  i.	 Click on the Insert tab and locate the Text group.
		  ii.	 Thereafter, click on the Text Box down button and choose from one of the options.
		  iii.	� The text box appears. When you insert a text box, the text inside is automatically selected. You can start 

typing to replace the text.
	 2.	 WordArt can be used to add artistic style text.
	 3.	 To add a watermark, follow these steps:
		  i.	 Open the document.
		  ii.	� Click on the Design tab.
		  iii.	� Click on the Watermark command in the Page Background group. A drop-down menu will appear.
		  iv.	 Select the type of watermark from the options. You can also customise your own watermark.
		  v.	 You will see a watermark will be added to your document behind the text.
	 4.	 The steps to crop an image are as follows:
		  i.	 Select the picture that you want to crop.
		  ii.	 The Picture Format contextual tab appears on the ribbon.
		  iii.	 Click on the Picture Format tab and locate the Size group.
		  iv.	 Now click on the Crop button. Black crop handles appear on the edges and corners of the picture.
		  v.	 Drag the crop handle inward to crop the image.
	 5.	� The SmartArt feature in Word is a visual representation of text or information. There are a variety of  

pre-defined SmartArt graphics that you can choose from.
E.	 Application based questions.
	 Answer may vary from student to student.
F.	 Competency based questions.
	 Answer may vary from student to student.

Assessment Time Page 50Answers
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EXPLORING WORD

LEARNING OUTCOMES
After going through this chapter, the students will be able to:  

	! �Understand how to use find and replace, spelling and grammar, and thesaurus features through logical thinking and 
observation.

	! �Learn to apply line spacing, paragraph spacing, and indentation in a formal learning classroom environment and 
observation.

	! Learn to add headers and footers, insert columns, and print a document through sensorial perception and observation.

LESSON PLAN 1 4 Periods

Topics covered in this lesson plan:						    
•	 Find and Replace Text						      Theory – 2 Periods
•	 Spelling and Grammar						      Practical – 2 Periods
•	 Thesaurus
•	 Line Spacing

LEARNING OBJECTIVES
By the end of this lesson, students will be able to:

	! define how to use Find and Replace text.
	! explain the steps for using Spelling and Grammar feature.
	! share how to use thesaurus.
	! insert line spacing in the document.

WARM UP
2.4.2.1: CG-1 Sustain effective communication skills for enhancing their oral abilities.

Ask following questions to the students and listen to their answers:
•	 How can you replace a repeating word in a paragraph all at once? 
•	 How can you update page numbers in a document?
	 1.	Before starting the chapter, guide the students to solve the exercise given in the Let’s Check-In section on page 53 

of the textbook.

CURRICULAR GOALS
2.4.1.1: CG-1 Students develop oral language skills using complex sentence 
structures to understand and communicate abstract ideas.
2.4.2.1: CG-1 Sustains effective communication skills for day-to-day interactions, 
enhancing their oral ability to express ideas.
8.5.1.1: CG-2 Develops an awareness of their personal and social behaviour 
towards themselves and others.

Topics No. of 
Periods

•	 Find and Replace Text
•	 Spelling and Grammar
•	 Thesaurus
•	 Line Spacing

4

•	 Paragraph Spacing
•	 Indentation
•	 Header and Footer
•	 Inserting Columns
•	 Printing a Document

5

5
TOTAL PERIODS: 9



Live Wire20

	 2.	Tell the students that Word lets you find and replace text along with checking spelling and grammar.
	 3.	Define the role of Find and Replace Text feature to the students.
	 4.	Share the steps for using find and replace feature with the students.

	 5.	Play the animated video on the topic Find and Replace Text provided in the Teacher’s Resource Kit to reinforce 
the concepts.

	 6.	Define Spelling and Grammar feature to the students and explain the role of this feature.
	 7.	Demonstrate the steps for using this feature as given in the textbook.

	 8.	Play the animated video on the topic Spelling and Grammar provided in the Teacher’s Resource Kit to reinforce 
the concepts.

8.5.1.1: CG-2 Develops an awareness of personal and social behaviour towards themselves and others.
	 9.	Encourage the students to do the activity given in the SDG section on page 63 of the textbook.  Motivate them to 

practice sustainability to achieve a better future for all.
		 Note: Students can also perform this activity at home under the guidance of their parents.
		  •	 Ask the students to find out the ways to reuse things.
		  •	 Guide the students in how to recycle and reuse things.
	 10.	Tell the students about Thesaurus feature in detail for better understanding of the topic.
	 11.	Define the meaning of synonyms and antonyms to the students.
	 12.	Elaborate the steps for applying thesaurus feature in a document as given in the textbook.

	 13.	Play the animated video on the topic Thesaurus provided in the Teacher’s Resource Kit to reinforce the concepts.
	 14.	Explain the meaning of line spacing to the students in detail.
	 15.	Demonstrate the steps for using line spacing feature to the students.

	 16.	Play the animated video on the topic Line Spacing provided in the Teacher’s Resource Kit to reinforce the concepts.
	 17.	Encourage the students to talk and share their thoughts about the topic given in the Let’s Talk section on page 56 

of the textbook. Motivate the use of mother tongue (if possible), otherwise let the child use any language or the 
language of instruction of the class.

Closure
Ensure that the students understand the role of synonyms and antonyms

1.	 What is the role of find and replace text feature?
2.	 What is thesaurus?

Assessment for Learners

Practical 1
Guide the students to do the activities in the lab as per the given instructions. 
	 1.	 Let the students learn to use find and replace and spelling & grammar feature by practically applying the steps 

given on page 53 and 54 of the textbook.
	 2.	 Let the students learn to use thesaurus by practically applying the steps given on page 54 and 55 of the textbook.
	 3.	 Let the students learn to insert line spacing practically applying the steps given on page 55 and 56 of the textbook.
	 4.	 Make sure the students learn how to perform all these operations and practice on their own. 
Practical 2
Guide the students to perform the activities given in the Hands on Computer section on page 62 and 63 of the textbook.
	 1.	 Take the students to the computer lab and divide the class into five groups.
	 2.	 Guide the students in creating a presentation as per the instructions given under activity A.
	 3.	 Help the students in completing the activity on their own.

Practical Session – 2 Periods
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LESSON PLAN 2 5 Periods

Topics covered in this lesson plan:						    
•	 Paragraph Spacing							       Theory – 3 Periods
•	 Indentation								        Practical – 2 Periods
•	 Headers and Footers
•	 Inserting Columns
•	 Printing a Document

LEARNING OBJECTIVES
By the end of this lesson, students will be able to:

	! demonstrate how to insert paragraph spacing and indentation.
	! use header and footer in the document.
	! explain the method for inserting columns in the document.
	! define the purpose of printing a document.

WARM UP
2.4.2.1: CG-1 Sustain effective communication skills for enhancing their oral abilities.

Before starting the period, ask if they have any doubts. Clarify them. Listen to their answers.
	 1.	Tell the students that they can insert a paragraph spacing to the document.
	 2.	Explain the steps used for inserting the paragraph spacing as given in the textbook.

	 3.	Play the animated video on the topic Paragraph Spacing provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 4.	Tell the students about indentation in brief for better understanding of the topic.
	 5.	Elaborate the steps for inserting indentation in a document.

	 6.	Play the animated video on the topic Indentation provided in the Teacher’s Resource Kit to reinforce the concepts.
	 7.	Define the role of header and footer and its importance in Word to the students.
	 8.	Explain the steps for using this feature to the students.

	 9.	Play the animated video on the topic Header and Footer provided in the Teacher’s Resource Kit to reinforce the 
concepts.

2.4.1.1: CG-1 Students develop oral language skills using complex sentence structures to understand and communicate 
abstract ideas.
	 10.	Ask the students to perform the activity given in Let’s Discuss section on page 58 of the textbook. Motivate the use 

of any language the students are comfortable with, otherwise let them use the language of instruction of the class.
•	 Divide the class in groups of five students.
•	 Ask each of these groups to discuss the purpose of header and footer.

	 11.	Tell the students that the document can be divided into columns.
	 12.	Explain the steps for inserting columns in a Word document.

	 13.	Play the animated video on the topic Inserting Columns provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 14.	Share with the students that they can print a document along with the steps for doing so.
	 15.	Tell them about the print settings, selecting printer, number of pages, print preview, and print to PDF options under 

Printing feature.
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	 16.	Play the animated video on the topic Printing a Document provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 17.	The students may read the additional information provided on the link given in the Let’s Read section of this 
chapter.

	 18.	Summarise the important topics to the class given in the Now I Know section on page 60 of the textbook.
	 19.	Discuss the chapter-end exercises given in the Assessment Time section on page 61 and 62 of the textbook. Assist 

students to write the answers in their notebook. 
		 Note: Answers are provided at the end of this Lesson Plan.
	 20.	Discuss the questions given in the Application based questions and Competency based questions on page 62 of the 

textbook. Ask the students to relate to the situation as a real-life incident and think about the solution. Help them 
write the answers in the notebook.

	 21.	Discuss the HOTS question given in the Think and Answer section on page 63 of the textbook. Help the students to 
write the answer in their notebook.

Closure
Ensure that the students understand the concepts of indentation, headers, footers, and columns.

1.	 What is a header?
2.	 How many columns can you insert in a document?

Assessment for Learners

Practical 1
Guide the students to do the activities in the lab as per the given instructions. 
	 1.	 Let the students learn to insert paragraph spacing and indentation by practically applying the steps given on 

page 56 of the textbook.
	 2.	 Let the students learn to add headers, footers, and columns by practically applying the steps given on page 57 

and 58 of the textbook.
	 3.	 Let the students learn to use all the options of printing feature by practically applying the steps given on page 

59 and 60 of the textbook.
	 4.	 Make sure the students learn how to perform all these operations and practice on their own. 
Practical 2
Guide the students to perform the activities given in the Hands on Computer section on page 62 and 63 of the textbook.
	 1.	 Take the students to the computer lab and divide the class into five groups.
	 2.	 Guide the students in creating a presentation as per the instructions given under activity B.
	 3.	 Help the students in completing the activity on their own.

Practical Session – 2 Periods

A.	 Tick the correct option. 
	 1. d. Find and Replace	 2. b. Thesaurus	 3. b. Line	 4. b. Spelling error
	 5. b. Insert
B.	 Match the following.
	 1. e. Ctrl + H 	 2. d. Proofing group	 3. b. Blue wavy underline	 4. a. Paragraph group
	 5. c. Ctrl + P

Assessment Time Page 61Answers
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C.	 Write T for true and F for false.
	 1. T		  2. F	 3. F	 4. F	 5. T
D.	 Answer the following.
	 1.	� Find command is used to find a specific text in the document and replace it with another text.
	 2.	� A header is the top portion of a document. It holds information like the title of the document, date, etc. 

Similarly, the bottom portion of a document is known as the footer of the document. It holds information like 
page numbers, author’s note, word meanings, etc.

	 3.	 To add an indent to the text you can follow these steps:
		  i.	� Place the cursor on the line or in the paragraph where you want to add the indent.
		  ii.	� From the Paragraph group, click on the Increase Indent button to add an indent to the paragraph. To 

decrease the indentation of the text, click on the Decrease Indent button.
	 4.	 A grammatical mistake is represented with blue double underlines.
	 5.	 To print a document, follow these steps:
		  i.	 Click on the File tab.
		  ii.	 Click on the Print option on the left pane. The Print window appears.
		  iii.	 Check your selection in Print Preview.
		  iv.	 Select the page numbers to be printed.
		  v.	 Select the printer.
		  vi.	 Click on Print.
E.	 Application based questions.
	 Answer may vary from student to student.
F.	 Competency based questions.
	 Answer may vary from student to student.
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A.	 Tick the correct options.
	 1. c. EEEPROM		  2. d. Print button is located on the right pane of the backstage view.
	 3. a. Insert tab		  4. c. .mp3		  5. c. F2
B.	 Write I for input and O for output for the following devices.
	 1. I		  2. O 	 3. I	 4. O	 5. I	     6. I
C.	 Complete the following table.

	

1024 MB 1 ................................

1024 ................................ 1 Terabyte (TB)

1024 ................................ 1 Petabyte (PB)

................................ PB 1 Exabyte (EB)

1024 KB 1 ................................

GB

TB

1024

Gigabyte (GB)

Megabyte (MB)

D.	 Fill in the blanks. 
	 1. Optical Mark Reader		  2. Non-volatile		  3. Video	
	 4. Cropping		  5. Paragraph
E.	 Write T for true and F for false.
	 1. T		  2. F	 3. F	 4. T	 5. F
F.	 Answer the following questions.
	 1.	� An output device displays the result of processing and the data entered into the computer. For example, 

Monitor, Printer.
	 2.	 To use the Thesaurus feature, follow these steps:
		  i.	 Select the word whose synonym you are looking for.
		  ii.	 Click on the Review tab.
		  iii.	� From the Proofing group, click on the Thesaurus command. This will open the Thesaurus pane on the 

right side of the Word window. It will display a list of words like the one you have selected.
		  iv.	 Right-click on any word and click on Insert button to replace the word.
	 3.	� Drives are like special storage boxes inside a computer where you can keep all your important things, like 

games, pictures, videos, and homework. This PC is a place on your computer where you can see and manage 
all your drives. When you open This PC, you’ll see icons for different drives like C: Drive, D: Drive, E: Drive, 
etc. The C: drive is usually the main drive of a PC. You can click on the drive icons to explore what is inside 
each drive. 

		  To transfer a file/ folder from one drive to another, follow these steps:
		  i.	 Double click on the This PC icon or open File Explorer.
		  ii.	 From the left pane, choose the drive from which the data will be transferred.
		  iii.	 Select the file or folder which you want to transfer to another drive.
		  iv.	� From the Clipboard group under Home tab, click on the Copy command or press Ctrl+C to copy the data. 

To move the data, click on the Cut command or press Ctrl+X.

Worksheet 1 Page 64Answers
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		  v.	 Now select the drive where you want to transfer the data.
		  vi.	 From the Clipboard group, under Home tab, click on the Paste command or press Ctrl+V.
		  vii.	 Your file / folder will be transferred to the desired drive.
	 4.	� File Explorer is a file manager application. It lets you to access, edit, manage, and organise your files and 

folders. You can use it to view, create, delete, copy, move, rename, and search files and folders.
	 5.	 The steps to insert a screenshot in Word are as follows:
		  i.	� On the Insert tab, in the Illustrations group, click on the Screenshot option. A menu with screenshots of 

all open programs and windows appears.
		  ii.	 Choose any one of the options if you want.
		  iii.	 If you want to insert a screenshot of only a portion of a window, choose the Screen Clipping option.
		  iv.	� Your windows will grey out and a crosshair sign will appear. Click and drag the mouse over the screen to 

select a portion of the window that you wish to insert.
		  v.	 When you are done, release the mouse. The screenshot will be added to the document.
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AI – INTERNET OF THINGS (IOT)

LEARNING OUTCOMES
After going through this chapter, the students will be able to:  

	! Learn about Internet of Things (IoT) in detail using effective methods of communication.
	! Understand about the basic elements of IoT through observation.
	! Learn the characteristics of IoT along with the uses of IoT in a formal learning classroom environment.

LESSON PLAN 1 2 Periods

Topics covered in this lesson plan:						    
•	 Internet of Things (IoT)						      Theory – 2 Periods
•	 Basic Elements of IoT

LEARNING OBJECTIVES
By the end of this lesson, students will be able to:

	! define Internet of Things (IoT).
	! explain the elements of IoT in detail.

WARM UP
2.4.2.1: CG-1 Sustain effective communication skills for enhancing their oral abilities.
Divide the class into four groups. Ask the students to share about the devices that they use have seen being used at their 
home. Let the groups discuss and share with the class.
	 1.	Before starting the chapter, guide the students to solve the exercise given in the Let’s Check-In section on page 68 

of the textbook.
	 2.	 Introduce the students with the concept of Internet of Things (IoT) in detail for better understanding of the further 

topics.
	 3.	Share some common examples with them along with the given in the textbook.

	 4.	Play the animated video on the topic Internet of Things (IoT) provided in the Teacher’s Resource Kit to reinforce 
the concepts.

	 5.	The students may read the additional information provided on the link given in the Let’s Read section of this 
chapter.

7.4.2.1: CG-4 Develops sensitivity towards social and natural environment.
	 6.	Encourage the students to do the activity given in the SDG section on page 75 of the textbook. Motivate them to 

practice sustainability to achieve a better future for all. 

CURRICULAR GOALS
2.4.1.1: CG-1 Students develop oral language skills using complex sentence 
structures to understand and communicate abstract ideas.
2.4.2.1: CG-1 Sustains effective communication skills for day-to-day interactions, 
enhancing their oral ability to express ideas.
7.4.2.1: CG-4 Develops sensitivity towards social and natural environment.

Topics No. of 
Periods

•	 Internet of Things (IoT)
•	 Basic Elements of IoT 2

•	 Characteristics of IoT
•	 Uses of IoT 3

6
TOTAL PERIODS: 5
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		 Note: Students can also perform this activity at home under the guidance of their parents.
		  •	 Explain the steps to be followed as per the activity given in the textbook.
		  •	 Ask the students to share their experience in the next period.
	 7.	Tell the students that there are some basics of elements of IoT.
	 8.	Explain all the basic elements of IoT to the students in detail.
	 9.	Define the role of each element with the help of an example.

	 10.	Play the animated video on the topic Basic Elements of IoT provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 11.	Help the students to complete the activity given in Milestone on page 70 of the textbook as per the instructions.

1.	 CONNECTIVITY
2.	 INTERNET OF THINGS
3.	 DATA PROCESSING
4.	 USER INTERFACE

Answer

Closure
Make sure the students understand IoT and its elements.

1.	 What is IoT?
2.	 Define connectivity in terms of IoT.

Assessment for Learners

LESSON PLAN 2 3 Periods

Topics covered in this lesson plan:						    
•	 Characteristics of IoT							      Theory – 2 Periods
•	 Uses of IoT								        Practical – 1 Period

LEARNING OBJECTIVES
By the end of this lesson, students will be able to:

	! learn about computer memory in detail.
	! define primary memory with its types.
	! define secondary memory with its types.

WARM UP
2.4.2.1: CG-1 Sustain effective communication skills for enhancing their oral abilities.

Ask students to discuss the previously taught topics and clear their doubts, if they have any.
	 1.	Revise the topics to the students which are taught in the previous class.
	 2.	State the characteristics of IoT to the students.
	 3.	Define all the points with the help of examples, if necessary.
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	 4.	Play the animated video on the topic Characteristics of IoT provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 5.	Explain about the evolution of Internet of Things over the years as given in the Time Travel section on page 71 of 
the textbook.

2.4.1.1: CG-1 Students develop oral language skills using complex sentence structures to understand and communicate 
abstract ideas.
	 6.	Ask the students to perform the activity given in Let’s Discuss section on page 71 of the textbook. Motivate the use 

of any language the students are comfortable with, otherwise let them use the language of instruction of the class.
		  •	 Divide the class in groups of three students.
		  •	 Ask the students to discuss and write the characteristics of IoT.
	 7.	Tell the students that IoT connects various devices for managing different things.
	 8.	Explain the functions of IoT in different devices and fields.

	 9.	Play the animated video on the topic Uses of IoT provided in the Teacher’s Resource Kit to reinforce the concepts.
	 10.	Help the students to complete the activity given in Milestone on page 72 of the textbook as per the instructions.
	 11.	Encourage the students to talk and share their thought about the topic given in the Let’s Talk section on page 73 

of the textbook. Motivate the use of mother tongue (if possible), otherwise let the child use any language or the 
language of instruction of the class.

	 12.	Summarise the important topics to the class given in the Now I Know section on page 73 of the textbook.
	 13.	Discuss the chapter-end exercises given in the Assessment Time section on page 73 and 74 of the textbook. Assist 

students to write the answers in their notebook. 
		 Note: Answers are provided at the end of this Lesson Plan.
	 14.	Discuss the questions given in the Application based questions and Competency based questions on page 74 of the 

textbook. Ask the students to relate to the situation as a real-life incident and think about the solution. Help them 
write the answers in the notebook.

	 15.	Discuss the HOTS question given in the Think and Answer section on page 75 of the textbook. Help the students to 
write the answer in their notebook.

Closure
Ensure that the students are now familiar with the characteristics and uses of IoT.

1.	 Define use of IoT in agriculture.
2.	 State any two characteristics of IoT.

Assessment for Learners

Practical 1
Assist the students and let them perform the following activity in the computer lab as given in the Hands on Computer 
section on page 75 of the textbook.
	 1.	 Take the students to the computer lab and divide the class into five groups.
	 2.	 Guide the students in performing as per the instructions given.
	 3.	 Help them in completing the activity as per point 1 to 4.
	 4.	 Make sure they understand how to do this activity.

Practical Session – 1 Period
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A.	 Tick the correct option. 
	 1. Speaker	 2. Meter	 3. Smartphones	 4. User	 5. Smartwatch
B.	 Write T for true and F for false.
	 1. F		  2. T	 3. F	 4. T 	 5. T
C.	 Match the following devices with their uses. 
	 1.	 c. Traffic management 	 2. d. Smart wearable 
	 3.	 b. Smart appliance		  4. a. Smart transport 
	 5.	 e. Smart agriculture
D.	 Answer the following questions.
	 1.	� The Internet of Things (IoT) are the everyday objects or devices which connects to the Internet. All these 

devices work on the concept of voice recognition, or through the smartphone applications.
		  Uses of IOT are as follow:
		�  Wearables - IoT technology is used in virtual glasses, fitness bands, and GPS tracking belts, and other wearable 

devices.
		�  Healthcare - The use of wearables or sensors connected to high-risk patients, allows doctors to monitor the 

patient's condition outside the hospital and in real-time.
	 2.	� IoT Devices - The devices and sensors connected to the networks are the primary devices. These are required 

to perform tasks and collect data. IoT is a big network and a control panel is required for managing it. It is also 
used to monitor the data flow from the devices to the network and vice-versa. 

		�  Connectivity - To make the IoT devices work properly, the process of connecting them with each other is 
necessary. These devices connect with the systems and the suitable platforms for working together. In this 
way, the devices can share data, work together, and can communicate from anywhere and anytime.

	 3.	� User Interface - It provides a medium for the user to interact with the devices. The user then controls the 
working of the devices as per their requirements. The hardware of IoT systems is also directed by the users for 
the maintenance of all these devices.

	 4.	 Some of the important characteristics of IoT: 
•	 IoT is all about connecting devices to the Internet or other networks. 
•	 IoT devices collect and generate vast amounts of data. 
•	 IoT devices use various communication rules to transmit data. 
•	 Sensors are a fundamental component of IoT devices. 
•	 IoT networks can handle any brand of devices to be added to it. 

	 5.	 a.	� Wearables - IoT technology is used in virtual glasses, fitness bands, and GPS tracking belts, and other wearable 
devices. These devices are interconnected to each other and keeping all the user data together at one place.

		  b.	� Smart Appliances - IoT enables the creation of smart appliances such as refrigerators, washing machines, 
and ovens that can be controlled remotely and offer enhanced functionality.

		  c.	� Agriculture - Various sensors allow farmers to keep track of the condition and stages of the soil. It helps 
with irrigation, efficient water usage, and determining the best time to sow crops. It also helps them to 
discover diseases in the soil and crop.

E.	 Application based questions.
	 Answer may vary from student to student.
F.	 Competency based questions.
	 Answer may vary from student to student.

Assessment Time Page 73Answers
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POWERPOINT: AN INTRODUCTION

LEARNING OUTCOMES
After going through this chapter, the students will be able to:  

	! Explain the purpose of presentation software using effective communication methods.
	! Learn to use appropriate layouts according to the requirement through logical thinking and observation.
	! Create presentation, add text and images to the slide through effective application methods.
	! Navigate between the slides and develop the habit of learning and application.

LESSON PLAN 1 4 Periods

Topics covered in this lesson plan:						    
•	 About Presentation							       Theory – 2 Periods
•	 Parts of PowerPoint Window						      Practical – 2 Periods
•	 Creating Presentation Using Template
•	 Adding a New Slide
•	 Duplicate Slides
•	 Copying a Slide
•	 Move Slides

LEARNING OBJECTIVES
By the end of this lesson, students will be able to:

	! define presentation and PowerPoint along with its parts.
	! create a presentation using template.
	! add, duplicate, copy, and move slides in a presentation.

CURRICULAR GOALS
2.4.1.1: CG-1 Students develop oral language skills using complex 
sentence structures to understand and communicate abstract 
ideas.
2.4.2.1: CG-1 Sustains effective communication skills for day-to-
day interactions, enhancing their oral ability to express ideas.
7.4.2.1: CG-4 Develops sensitivity towards social and natural 
environment.

Topics No. of 
Periods

•	 About Presentation
•	 Parts of PowerPoint Window
•	 Creating Presentation Using Template
•	 Adding a New Slide
•	 Duplicate Slides
•	 Copying a Slide
•	 Move Slides

4

•	 Inserting Slide from Another Presentation
•	 Deleting a Slide
•	 Hide a Slide
•	 Dividing a Presentation
•	 Rearranging Slides
•	 Saving a Presentation
•	 Opening a Presentation
•	 Closing a Presentation

5

7
TOTAL PERIODS: 9
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WARM UP
2.4.2.1: CG-1 Sustain effective communication skills for enhancing their oral abilities.
Divide class into four groups, and assign a different topic to each group, such as ‘Computer Memory’, ‘Parts of a Computer’, 
'Internet', and ‘CPU’.
•	 Ask each group to divide the sheet of paper into four parts and write four points along with drawings if possible.
•	 Students can also draw the outline of the sheet and decorate it with crayons. 
	 1.	Before starting the chapter, guide the students to solve the exercise given in the Let’s Check-In section on page 76 

of the textbook.
	 2.	 Introduce the students to the concept of Presentation. Tell them the importance and benefits of a good presentation.
	 3.	 Introduce ‘PowerPoint’ and describe its use. Also, discuss the advantages of presenting the information in the form 

of a presentation.
	 4.	Explain the steps to start PowerPoint to the students by demonstrating it in the computer lab.

	 5.	Play the animated video on the topic About Presentation provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 6.	Mark the parts of the PowerPoint window. Discuss the function of each of the parts. 
	 7.	Talk about the slide’s navigation pane and slide pane.

	 8.	Play the animated video on the topic Parts of PowerPoint Window provided in the Teacher’s Resource Kit to 
reinforce the concepts.

	 9.	Explain about the evolution of PowerPoint version over the years as given in the Time Travel section on page 79 of 
the textbook.

	 10.	Explain the meaning of template to the students.
	 11.	Define the steps for creating a presentation using template.

	 12.	Play the animated video on the topic Creating Presentation Using Template provided in the Teacher’s Resource 
Kit to reinforce the concepts.

7.4.2.1: CG-4 Develops sensitivity towards social and natural environment.
	 13.	Encourage the students to do the activity given in the SDG section on page 89 of the textbook. Motivate them to 

practice sustainability to achieve a better future for all. 
		 Note: Students can also perform this activity at home under the guidance of their parents.
		  •	 Explain the steps to be followed as per the activity given in the textbook.
		  •	 Ask the students to share their experience in the next period.
	 14.	The students may read the additional information provided on the link given in the Let’s Read section of this 

chapter.
	 15.	Tell the students that they can add as many slides as they want in their presentation.
	 16.	Demonstrate the steps for adding a slide in a presentation to the students.

	 17.	Play the animated video on the topic Adding a New Slide provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 18.	Help the students to complete the activity given in Milestone on page 80 of the textbook as per the instructions.

1.	 Slide Navigation Pane	 2. Slide Pane	 3. Title Bar	 4. Home tab and Slides group

Answer

	 19.	Tell the students that they can duplicate any slide.
	 20.	Show them the steps for duplicating the slides for better understanding.

	 21.	Play the animated video on the topic Duplicate Slides provided in the Teacher’s Resource Kit to reinforce the concepts.
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	 22.	Tell the students that they can copy any slide in a presentation.
	 23.	Elaborate the steps for copying slides from a presentation.

	 24.	Play the animated video on the topic Copying a Slide provided in the Teacher’s Resource Kit to reinforce the concepts.
	 25.	Explain to the students that any slide can be moved easily.
	 26.	Demonstrate the steps for moving slides in a presentation.

	 27.	Play the animated video on the topic Move Slides provided in the Teacher’s Resource Kit to reinforce the concepts.

Closure
Assign the task to the students to create a presentation on the topic ‘Light Pollution’. The presentation should contain 
at least 5 slides.

1.	 What is a slide? 
2.	 What is the role of a placeholder?

Assessment for Learners

Practical 1
Guide the students to do the activities in the lab as per the given instructions. 
	 1.	 Introduce the students with PowerPoint and show them the steps to start PowerPoint.
	 2.	 Let the students learn about all the components of PowerPoint window.
	 3.	 Let the students learn to create a presentation using a template by practically applying the steps given on page 

79 of the textbook.
	 4.	 Let the students learn to add a slide by practically applying the steps given on page 80 of the textbook.
Practical 2
Guide the students to do the activities in the lab as per the given instructions. 
	 1.	 Let the students learn to duplicate slides in a presentation using a template by practically applying the steps 

given on page 81 of the textbook.
	 2.	 Let the students learn to copy slides in a presentation using a template by practically applying the steps given 

on page 81 of the textbook.
	 3.	 Let the students learn to move slides in a presentation using a template by practically applying the steps given 

on page 81 of the textbook.

Practical Session – 2 Periods

LESSON PLAN 2 5 Periods

Topics covered in this lesson plan:						    
•	 Inserting Slide from Another Presentation				    Theory – 2 Periods
•	 Deleting a Slide						      	 Practical – 3 Periods
•	 Hide a Slide
•	 Dividing a Presentation
•	 Rearranging Slides
•	 Saving a Presentation
•	 Opening a Presentation
•	 Closing a Presentation
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LEARNING OBJECTIVES
By the end of this lesson, students will be able to:

	! explain about inserting a new slide and duplicating a slide.
	! show how to move and rearrange a slide.
	! demonstrate the steps for deleting and hiding a slide in a presentation.
	! apply the steps to save, close, and open an existing presentation.

WARM UP

2.4.2.1: CG-1 Sustain effective communication skills for enhancing their oral abilities.

Ask students to identify and memorise all the components of PowerPoint window correctly. Make sure they know it.
	 1.	Revise the topics to the students which are taught in the previous class.
	 2.	Explain to them that sometimes they also need to move slides from one location to another to maintain a smooth 

content flow.
	 3.	Demonstrate the steps to insert slides from another presentation. 

	 4.	Play the animated video on the topic Inserting Slide from Another Presentation provided in the Teacher’s 
Resource Kit to reinforce the concepts.

	 5.	Demonstrate the steps to delete a slide to the students. Tell them both the methods of using the ribbon and the 
keyboard.

	 6.	Play the animated video on the topic Deleting a Slide provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 7.	Tell them that at times we need to hide some slides so that they don’t become a part of the presentation, rather 
deleting the slide, we can hide it because it might be used in the future.

	 8.	Play the animated video on the topic Hide a Slide provided in the Teacher’s Resource Kit to reinforce the concepts.
	 9.	Tell the students that a long presentation can be divided into sections.
	 10.	Define the steps for dividing a presentation to the students for better understanding.

	 11.	Play the animated video on the topic Dividing a Presentation provided in the Teacher’s Resource Kit to reinforce 
the concepts.

	 12.	Define the concept of moving and rearranging the slides to the students with the help of detailed steps given in the 
textbook.

	 13.	Play the animated video on the topic Rearranging Slides provided in the Teacher’s Resource Kit to reinforce the 
concepts.

2.4.1.1: CG-1 Students develop oral language skills using complex sentence structures to understand and communicate 
abstract ideas.
	 14.	Ask the students to perform the activity given in Let’s Discuss section on page 84 of the textbook. Motivate the use 

of any language the students are comfortable with, otherwise let them use the language of instruction of the class.
•	 Divide the class in groups of four students each.
•	 Guide the students in learning the reuse of slides on their own.

	 15.	Define the steps for saving a presentation to the students in detail.
	 16.	Tell the students how they can open an existing presentation using the labelled steps given in the textbook. 
	 17.	Explain the steps and methods for closing a presentation to the students in detail.

	 18.	Play the animated video on the topic Saving, Opening, and Closing a Presentation provided in the Teacher’s 
Resource Kit to reinforce the concepts.
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	 19.	Encourage the students to talk and share their thoughts about the topic given in the Let’s Talk section on page 86 
of the textbook. Motivate the use of mother tongue (if possible), otherwise let the child use any language or the 
language of instruction of the class.

	 20.	Summarise the important topics to the class given in the Now I Know section on page 86 of the textbook
	 21.	Discuss the chapter-end exercises given in the Assessment Time section on page 86 and 87 of the textbook. Assist 

students to write the answers in their notebook. 
		 Note: Answers are provided at the end of this Lesson Plan.
	 22.	Discuss the questions given in the Application based questions and Competency based questions on page 88 of the 

textbook. Ask the students to relate to the situation as a real-life incident and think about the solution. Help them 
write the answers in the notebook.

	 23.	Discuss the HOTS question given in the Think and Answer section on page 89 of the textbook. Help the students to 
write the answer in their notebook.

Closure
Ask the students to prepare a presentation on the topic, ‘Noise pollution’. Make it attractive and save it 

1.	 Can you hide a slide using just a context menu?
2.	 What is the default view of a presentation?

Assessment for Learners

Practical 1
Guide the students to do the activities in the lab as per the given instructions. 
	 1.	 Let the students learn to insert slide from another presentation by practically applying the steps given on page 

82 of the textbook.
	 2.	 Let the students learn to delete and hide a slide by practically applying the steps given on page 83 of the 

textbook.
	 3.	 Let the students learn to divide a presentation by practically applying the steps given on page 83 of the 

textbook.
Practical 2
Guide the students to do the activities in the lab as per the given instructions. 
	 1.	 Let the students learn to rearrange slides in a presentation using a template by practically applying the steps 

given on page 84 of the textbook.
	 2.	 Let the students learn to save and open a presentation using a template by practically applying the steps given 

on page 84 and 85 of the textbook.
	 3.	 Let the students learn to close a presentation using a template by practically applying the steps given on page 

85 and 86 of the textbook.
Practical 3
Assist the students and let them perform the following activity in the computer lab as given in the Hands on Computer 
section on page 88 of the textbook.
	 1.	 Take the students to the computer lab and divide the class into five groups.
	 2.	 Guide the students in performing as per the instructions given.
	 3.	 Help them in completing the activity A and B as per the instructions in each.
	 4.	 Make sure they understand how to do this activity.

Practical Session – 3 Periods
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A.	 Tick the correct option. 
	 1. d. Slide	 2. a. Ctrl + S	 3. c. Duplicate Slide	 4. a. Reuse Slide	 5. a. .pptx
B.	 Match the following.
	 1. d. New Slides option 	 2. b. Status bar 	 3. a. Title bar 	 4. e. Slide pane	 5. c. Slides group
C.	 Write T for true and F for false.
	 1. F		  2. T	 3. F	 4. F 	 5. T
D.	 Answer the following questions.
	 1.	� A slide is an individual page of a presentation. Whereas a presentation is a way of representing information 

using images, graphs, text, audio, and video clips.
	 2.	� A Placeholder is the dotted rectangular box where you can add text, images, graphs, and so on.
	 3.	 To rearrange the slides, follow these steps: 

i.	 In the Normal view, select the thumbnail of the slide. 
ii.	 Drag and move the slide to the desired location and release the mouse button.

		  To reuse the slides, follow these steps:
i.	 On the Home tab, in the Slides group, click on the New Slide down arrow and select Reuse Slides. 
ii.	 The Reuse Slides pane opens on the right. A list of a few suggestions appears. 
iii.	 Select the presentation that has slides that you want to use. The presentation is opened in the Reuse Slides 

pane.
iv.	 Select the position in the current presentation. 
v.	 Click on the slide you want to insert from the Reuse Slide pane. 
vi.	 Close the Reuse Slide pane.

	 4.	 a.	 Add a new slide - The steps to insert a new slide are as follows: 
i.	 Select the slide after which you want to add a new slide. 
ii.	 On the Home tab, in the Slides group, click on the New Slide down button. 
iii.	 A menu with several slide layout options appears. Choose the desired one.

		  b.	� Divide a presentation - You can divide a presentation into sections to organise and format a longer 
presentation. The steps to divide a presentation are as follows: 

i.	 Select the slide that you want to be first to appear in the new section. 
ii.	 On the Home tab, in the Slides group, click on the Section button. 
iii.	 Click on the Add Section option from the drop-down menu. 
iv.	� The Rename Section dialog box appears. Under the Section name header, type in the name of the section, 

and click on the Rename button.
	 c.	� Duplicate a slide - You can duplicate slides as and when required in a presentation. To insert a copy of a slide 

immediately after the original slide, follow the given steps: 
i.	 In the Normal view, right-click on thumbnail of the slide that you want to copy. 
ii.	 Click on the Duplicate Slide option.

	 d.	� Hide a slide - When you do not need a slide for a specific presentation but might need it later, you can hide 
the slide instead of deleting it. The hidden slides are available from the Slide Navigation Pane but are not 
displayed in the slide shows.

Assessment Time Page 86Answers
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		  The steps to hide or unhide slides are as follows: 
i.	 Select the slide that to wish to hide. 
ii.	 Right-click on the slide thumbnail and click on the Hide Slide option. Similarly, you can also unhide a 

hidden slide.
	 5.	� Saving a Presentation - A PowerPoint presentation is saved with .pptx extension. To save a presentation, 

follow the steps given below. 
i.	 Click on the File tab. 
ii.	 Click on the Save As option. 
iii.	 Click on Browse to locate and select the folder where you wish to save the file. 
iv.	 The Save As dialog box opens. In the File Name text box, type in the name for the presentation. 
v.	 Now click on the Save button. The presentation will be saved in the selected folder.

		  Open Presentation - The steps to open an existing presentation are as follows: 
i.	 Click on the File tab. 
ii.	 Click on the Open option. 
iii.	 The Open pane appears. Locate and click on the presentation file in the right pane that you wish to open. 
iv.	 You will see that the selected presentation file will open in the PowerPoint window.

		  Close Presentation - To close a PowerPoint, follow the given steps. 
i.	 Click on the File tab. 
ii. 	 Click on the Close button. If the presentation file is not saved, a dialog box asking to save the file will 

appear. Click on Save to save the presentation, Don’t Save to not save the file, and Cancel to cancel the 
action of closing the presentation. 

iii.	 If the file is already saved, the presentation window will be closed.
E.	 Application based questions.
	 Answer may vary from student to student.
F.	 Competency based questions.
	 Answer may vary from student to student.
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SCRATCH CODING AND GAMES

LEARNING OUTCOMES
After going through this chapter, the students will be able to:  

	! Learn to change sprites and work with multiple sprites through logical thinking.
	! �Work on how to change, duplicate, and delete a Sprite along with the location of a Sprite and developing the habit of learning.
	! Understand the coordinate system of Scratch using effective methods and applications.
	! Learn about Looks block, Events block, and Sensing block through observation.

LESSON PLAN 1 4 Periods

Topics covered in this lesson plan:						    
•	 Working with Sprites							      Theory – 2 Periods
•	 Choosing a Backdrop						     	 Practical – 2 Periods
•	 Working with Multiple Sprites
•	 Coordinates

LEARNING OBJECTIVES
By the end of this lesson, students will be able to:

	! change Sprites and work with multiple Sprites.
	! choose a backdrop.
	! understand the coordinate system in Scratch.

WARM UP
2.4.2.1: CG-1 Sustain effective communication skills for enhancing their oral abilities.

Divide the class in to five groups. Ask following questions to the students:
•	 How will you describe the position of sprite to someone?
•	 Which button is used to stoP the sprite from performing on stage?
	 1.	Before starting the chapter, guide the students to solve the exercise given in the Let’s Check-In section on page 90 

of the textbook.
	 2.	Tell the students that they can perform various actions with sprite.

CURRICULAR GOALS
2.4.1.1: CG-1 Students develop oral language skills using complex sentence 
structures to understand and communicate abstract ideas.
2.4.2.1: CG-1 Sustains effective communication skills for day-to-day 
interactions, enhancing their oral ability to express ideas.
7.4.2.1: CG-4 Develops sensitivity towards social and natural environment.

Topics No. of 
Periods

•	 Working with Sprites
•	 Choosing a Backdrop
•	 Working with Multiple Sprites
•	 Coordinates

4

•	 Events Blocks
•	 Sensing Blocks
•	 Control Blocks
•	 Games Coding

5

8
TOTAL PERIODS: 9
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	 3.	Show them how they can create a sprite on their own.
	 4.	Tell the students that they can select any sprite from the sprite library and use a picture as a sprite too.
	 5.	 Inform the students that they can delete a sprite by showing the steps for the same.

	 6.	Play the animated video on the topic Working with Sprites provided in the Teacher’s Resource Kit to reinforce the 
concepts.

	 7.	Tell them that the stage behind the sprite does not need to remain empty, they can add a background to it, which is 
known as a backdrop.

	 8.	Show them the steps to add a backdrop to the stage.
	 9.	Play the animated video on the topic Choosing a Backdrop provided in the Teacher’s Resource Kit to reinforce the 

concepts.
	 10.	Tell the students that they can also work with multiple sprite at the same time.

	 11.	Play the animated video on the topic Working with Multiple Sprites provided in the Teacher’s Resource Kit to 
reinforce the concepts.

	 12.	Encourage the students to talk and share their thoughts about the topic given in the Let’s Talk section on page 93 
of the textbook. Motivate the use of mother tongue (if possible), otherwise let the child use any language or the 
language of instruction of the class.

	 13.	Tell the students that Scratch uses a system to determine the location of a sprite on the screen, known as Coordinate 
system.

	 14.	Explain the concept of coordinate system to the students.
	 15.	Explain them the process of repositioning a sprite in Scratch. Show them the working of the go to, glide, and go to 

a random block.
	 16.	Play the animated video on the topic Coordinates provided in the Teacher’s Resource Kit to reinforce the concepts.

7.4.2.1: CG-4: Develops sensitivity towards social and natural environment.
	 17.	Encourage the students to do the activity given in the SDG section on page 101 of the textbook. Motivate them to 

practice sustainability to achieve a better future for all. 
		 Note: Students can also perform this activity at home under the guidance of their parents.
		  •	 Explain the steps to be followed as per the activity given in the textbook.
		  •	 Ask the students to share their experience in the next period.

Closure
Ensure that the students are now familiar with blocks, working with sprites, choosing a backdrop and working with 
multiple sprites.

1.	 What is a backdrop? 
2.	 Which category of blocks are used to change the appearance of the sprite?

Assessment for Learners

Practical 1
Guide the students to do the activities in the lab as per the given instructions. 
	 1.	 Take the students to the computer lab and help them in starting scratch.
	 2.	 Let the students learn to work with sprites by practically applying the steps given on page 90 to 92 of the 

textbook.
	 3.	 Let the students learn to change the backdrop by practically applying the steps given on page 92 of the 

textbook.

Practical Session – 2 Periods
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Practical 2
Guide the students to do the activities in the lab as per the given instructions. 
	 1.	 Take the students to the computer lab and help them in starting scratch.
	 2.	 Let the students learn to work with multiple sprites using a template by practically applying the steps given on 

page 93 of the textbook.
	 3.	 Let the students learn the concept of coordinates by observing the Scratch stage on their own and as given on 

page 93 of the textbook.

LESSON PLAN 2 5 Periods

Topics covered in this lesson plan:						    
•	 Events Blocks							       Theory – 2 Periods
•	 Sensing Blocks							       Practical – 3 Periods
•	 Control Blocks
•	 Games Coding

LEARNING OBJECTIVES
By the end of this lesson, students will be able to:

	! learn about events blocks.
	! use sensing blocks in the script.
	! learn to use control blocks.

WARM UP
2.4.2.1: CG-1: Sustain effective communication skills for enhancing their oral abilities.

Ask students to revise the topics taught in the previous class and clarify if there is any doubt.
	 1.	Tell the students about the events block and how it is used to trigger certain events.
	 2.	Discuss the working of the blocks given in the table on page 94 and 95 of the textbook. Clarify their doubts if they 

have any.
	 3.	Play the animated video on the topic Events Blocks provided in the Teacher’s Resource Kit to reinforce the concepts.

	 4.	Explain to the students that they can make a script using the sensing block as it helps the user to interact with the 
sprite at certain points of running the script.

	 5.	Discuss the working of the sensing block given in the table on page 95 and 96 of the textbook. Clarify their doubts 
if they have any.

	 6.	Play the animated video on the topic Sensing Blocks provided in the Teacher’s Resource Kit to reinforce the concepts.
2.4.1.1: CG-1 Students develop oral language skills using complex sentence structures to understand and communicate 
abstract ideas.
	 7.	Ask the students to perform the activity given in Let’s Discuss section on page 96 of the textbook. Motivate the use 

of any language the students are comfortable with, otherwise let them use the language of instruction of the class.
		  •	 Divide the class into groups of two students each.
		  •	 Guide the students to complete the activity as per the instructions.
	 8.	The students may read the additional information provided on the link given in the Let’s Read section of this 

chapter.
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	 9.	Tell the students about the control block and its role in applying the condition in the script.
	 10.	Discuss the working of the blocks given in the table on page 97 of the textbook. Clarify their doubts if they have 

any.
	 11.	Play the animated video on the topic Control Blocks provided in the Teacher’s Resource Kit to reinforce the concepts.

	 12.	Help the students to complete the activity given in Milestone on page 98 of the textbook as per the instructions.

1.	 d. Runs the script if the green flag is clicked
2.	 e. Tests if a sprite is touching a specified colour
3.	 c. Checks the condition
4.	 a. Asks user a question and wait for the response
5.	 b. Tests if a key is pressed on the keyboard

Answer

	 13.	Share with the students that they can create games, stories, animations, etc using different blocks.
	 14.	Guide the students in creating a game using the script and steps as given in page 98 of the textbook.
	 15.	Tell the students about computer memory in brief.

	 16.	Play the animated video on the topic Games Coding provided in the Teacher’s Resource Kit to reinforce the concepts.
	 17.	Explain about the evolution of blocks palette through the versions of Scratch as given in the Time Travel section on 

page 99 of the textbook.
	 18.	Summarise the important topics to the class given in the Now I Know section on page 99 of the textbook
	 19.	Discuss the chapter-end exercises given in the Assessment Time section on page 99 to 101 of the textbook. Assist 

students to write the answers in their notebook. 
		 Note: Answers are provided at the end of this Lesson Plan.
	 20.	Discuss the questions given in the Application based questions and Competency based questions on page 101 of the 

textbook. Ask the students to relate to the situation as a real-life incident and think about the solution. Help them 
write the answers in the notebook.

	 21.	Discuss the HOTS question given in the Think and Answer section on page 101 of the textbook. Help the students 
to write the answer in their notebook.

Closure
Motivate the students to practice all the different blocks in Events block and sensing block.

1.	 Which category of block is used to trigger a script? 
2.	 Which category of blocks is used to make a script interactive?

Assessment for Learners

Practical 1
Guide the students to do the activities in the lab as per the given instructions. 
	 1.	 Take the students to the computer lab and help them in starting scratch.
	 2.	 Let the students learn to use events blocks by practically applying the steps given on page 94 and 95 of the 

textbook.
	 3.	 Let the students learn to use sensing blocks by practically applying the steps given on page 95 and 96 of the 

textbook.

Practical Session – 3 Periods
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Practical 2
Guide the students to do the activities in the lab as per the given instructions. 
	 1.	 Take the students to the computer lab and help them in starting scratch.
	 2.	 Let the students learn to use control blocks using a template by practically applying the steps given on page 

97 of the textbook.
	 3.	 Let the students learn to create the Scratch game on their own and as given on page 98 of the textbook.
Practical 3
Assist the students and let them perform the following activity in the computer lab as given in the Hands on Computer 
section on page 102 of the textbook.
	 1.	 Take the students to the computer lab and divide the class into five groups.
	 2.	 Guide the students in performing as per the instructions given.
	 3.	 Make sure they understand how to do this activity.

A.	 Tick the correct option. 
	 1.	 b. 480 X 360		  2. a. 	 3. c. 

	 4. d. 	 5. d. Backdrop

B.	 Fill in the blanks.
	 1. 0,0		  2. -240,240	 3. Events	 4. Sensing	 5. Control
C.	 Write T for true and F for false.
	 1. T		  2. T	 3. F	 4. F	 5. T
D.	 Answer the following questions.
	 1.	� Scratch uses a coordinate system to determine the position of a Sprite. It uses two values—X-position and 

Y-position. These values together form a coordinate. The X-position defines the horizontal position whereas 
the Y-position defines the vertical position of the Sprite.

	 2.	� The Events blocks have commands that trigger either a single script or multiple scripts. An event can take 
place by clicking of a mouse button, pressing of a keyboard key, or clicking on any icon or a sprite.

		

Block Description
This block runs a script when the Green Flag is clicked.

This block runs blocks under it when the specified key is pressed.

This block runs a script when the sprite is clicked.

	 3.	� The Sensing blocks are used to detect some actions, such as the location of the mouse-pointer, whether a sprite 
is touching another sprite, or a key is pressed. It is also used to take input from the user.

		

Block Description

This block tests if a key is pressed on the keyboard.

This block tests if the sprite is touching a specified colour.

Assessment Time Page 99Answers
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	 4.	� Sometimes it might be required to pe rform a task based on given conditions. This decision making is possible 
in Scratch using the Control blocks. The table given below lists the purpose of the Control blocks.

		

Block Description
This block checks the condition. If the condition is true, it executes the blocks 
inside it.

This block checks the condition. If the condition is true, it executes the blocks 
inside the first section, otherwise it executes the blocks inside the second section.

	 5. 	a.	 Changing backdrop - To choose a backdrop, follow these steps: 
	 i.	 Click on the Choose a Backdrop button. The Backdrop library opens. 
	 ii.	� Scroll down to find the suitable backdrop and click on it. The backdrop will be applied to your 

project.
		  b.	 Creating a Sprite - To create a new sprite, follow these steps: 

	 i.	 Hover the mouse pointer over the Choose a Sprite button. A pop-up menu appears. 
	 ii.	 Click on the Paint button in the pop-up menu. A new window opens. 
	 iii.	 In this window, you can create your own sprite with the help of the tools provided.

		  c.	� Working with sprites - Sprites are the actors that perform the actions on the stage according to the scripts 
that we have written. Scratch allows you to create your Sprite or choose a Sprite from its Sprite library.

E.	 Application based questions.
	 Answer may vary from student to student.
F.	 Competency based questions.
	 Answer may vary from student to student.
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THE INTERNET

LEARNING OUTCOMES
After going through this chapter, the students will be able to:  

	! Define the terminologies related to Internet Network in an effective way of communication.
	! Use appropriate keywords to collect information through logical thinking.
	! Label the parts of a browser window through observation.
	! Make responsible decision while browsing and develop the habit of learning.

LESSON PLAN 6 Periods

Topics covered in this lesson plan:						    
•	 About Internet							       Theory – 4 Periods
•	 Terms Related to the Internet						      Practical – 2 Periods
•	 Basic Requirements for an Internet Connection
•	 Microsoft Edge

LEARNING OBJECTIVES
By the end of this lesson, students will be able to:

	! define what is the Internet.
	! explain the terminologies related to the Internet.
	! explain the requirements for Internet connection.
	! introduce Microsoft Edge and label the parts of a browser window.

WARM UP
2.4.2.1: CG-1 Sustain effective communication skills for enhancing their oral abilities.

Conduct the following activity in class as an icebreaker—
Write the word ‘Internet’ on the board in the centre and circle the word. Now divide the class into four groups and ask students 
to think and write something related to it that comes to their mind in their notebook. 
Let them discuss their answers with their group. Classify and list down the important points given by students to be discussed 
during class. 
	 1.	Before starting the chapter, guide the students to solve the exercise given in the Let’s Check-In section on page 103 

of the textbook.

CURRICULAR GOALS
2.4.1.1: CG-1 Students develop oral language skills using complex sentence 
structures to understand and communicate abstract ideas.
2.4.2.1: CG-1 Sustains effective communication skills for day-to-day 
interactions, enhancing their oral ability to express ideas.
7.4.2.1: CG-4 Develops sensitivity towards social and natural environment.

Topics No. of 
Periods

•	 About Internet
•	 Terms Related to the Internet
•	 Basic Requirements for an 

Internet Connection
•	 Microsoft Edge

6

9
TOTAL PERIODS: 6
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	 2.	Explain the uses of Internet and how it has made our lives easier.
	 3.	Play the animated video on the topic About Internet provided in the Teacher’s Resource Kit to reinforce the 

concepts.
	 4.	Tell the students that there are some terms which are commonly used with the Internet.
	 5.	Define the meaning of WWW, web page, website, and home page and how they are related to each other.
	 6.	Explain the meaning of URL and its full form.
	 7.	Elaborate the three parts of a URL which are protocol, domain name, and path of the file.
	 8.	Define the meaning of web browser, hyperlink, download, and upload along with their examples.

	 9.	Play the animated video on the topic Terms Related to the Internet provided in the Teacher’s Resource Kit to 
reinforce the concepts.

	 10.	Encourage the students to talk and share their thoughts about the topic given in the Let’s Talk section on page 105 
of the textbook. Motivate the use of mother tongue (if possible), otherwise let the child use any language or the 
language of instruction of the class.

	 11.	The students may read the additional information provided on the link given in the Let’s Read section of this 
chapter.

	 12.	Tell them that to establish an Internet connection, we need to have some equipment such as, a computer, modem, 
ISP, web browser, etc.

	 13.	Play the animated video on the topic Basic Requirements for an Internet Connection provided in the Teacher’s 
Resource Kit to reinforce the concepts.

	 14.	Help the students to complete the activity given in Milestone on page 106 of the textbook as per the instructions.

1.	 World Wide Web		  2. Internet Service Provider		  3. Uniform Resource Locator

Answer

	 15.	Explain what is Microsoft Edge to the students along with brief history.
	 16.	Demonstrate the steps for starting Microsoft Edge by using both the methods as given in the textbook.
	 17.	Show them the various parts of a Microsoft Edge like New tab, Back button, and parts of the ribbon.
	 18.	Demonstrate the uses of these parts one by one by performing basic operations in Microsoft Edge for better 

understanding of the topics.
	 19.	Play the animated video on the topic Microsoft Edge provided in the Teacher’s Resource Kit to reinforce the 

concepts.
	 20.	Explain about the evolution of Windows Internet Explorer over the years as given in the Time Travel section on 

page 107 of the textbook.
2.4.1.1: CG-1 Students develop oral language skills using complex sentence structures to understand and communicate 
abstract ideas.
	 21.	Ask the students to perform the activity given in Let’s Discuss section on page 108 of the textbook. Motivate the use 

of any language the students are comfortable with, otherwise let them use the language of instruction of the class.
•	 Divide the class in groups of four students each.
•	 Ask the students to discuss about different parts of browser window.

7.4.2.1: CG-4 Develops sensitivity towards social and natural environment.
	 22.	Encourage the students to do the activity given in the SDG section on page 110 of the textbook. Motivate them to 

practice sustainability to achieve a better future for all. 
		 Note: Students can also perform this activity at home under the guidance of their parents.

•	 Explain the steps to be followed as per the activity given in the textbook.
•	 Ask the students to share their experience in the next period.



Live Wire 45

	 23.	Summarise the important topics to the class given in the Now I Know section on page 108 of the textbook
	 24.	Discuss the chapter-end exercises given in the Assessment Time section on page 108 and 109 of the textbook. Assist 

students to write the answers in their notebook. 
		 Note: Answers are provided at the end of this Lesson Plan.
	 25.	Discuss the questions given in the Application based questions and Competency based questions on page 109 of the 

textbook. Ask the students to relate to the situation as a real-life incident and think about the solution. Help them 
write the answers in the notebook.

	 26.	Discuss the HOTS question given in the Think and Answer section on page 110 of the textbook. Help the students 
to write the answer in their notebook.

Closure
Ask the students to surf the Internet using Edge browser and look up the best tourist places in Gujarat.

1.	 What is the use of Reading List? 
2.	 What is the use of favourites?

Assessment for Learners

Practical 1
Guide the students to do the lab activities as per the given instructions.
	 1.	 Take the students to the computer lab and let them settle down in five groups.
	 2.	 Introduce the students to the Internet and its features.
	 3.	 Let the students start Microsoft Edge and learn about its parts by applying steps given on pages 106.
	 4.	 Let the students understand the concept of web browser and how to use it properly by following the steps 

given on page 107 of the textbook.
Practical 2
Guide the students to perform the activities given in the Hands on Computer section on page 110 of the textbook.
	 1.	 Take the students to the computer lab and divide the class into five groups.
	 2.	 Guide the students in performing all the operations given under A and B.
	 3.	 Make sure that all the students perform all these operations on their own.

Practical Session – 2 Periods

A.	 Tick the correct option. 
	 1. c. https://	 2. a. WWW	 3. b. Apple Safari	 4. d. Refresh	 5. a. Web browser
B.	 Write T for true and F for false.
	 1. T		  2. F	 3. T	 4. F	 5. F
C.	 Who am I?
	 1. The Internet	 2. An Internet Service Provider (ISP)	 3. Home Page	 4. Web Browser
	 5. URL
D.	 Answer the following questions.
	 1.	� Internet means interconnected network of computers. A network is a group of two or more computers 

connected. Thus, we can say that the Internet is a network that connects millions of computers with each other 
all over the world. It is the largest network in the world.

		  Terms related to internet are:

Assessment Time Page 108Answers
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•	� Webpage - The Internet is a storehouse of information. Information is made available on special pages 
called webpages. A webpage is the single page of information. It can contain various types of content like, 
text, images, videos, links, etc.

•	� Website - A website is a group of related webpages. All the webpages of a website are linked together. 
Websites that are created by individuals, organisations, and government. 

•	� Home Page - A homepage is the first or front page of a website. It is the first page you see when you visit 
a website using a web browser.

	 2.	� A website is a group of related webpages. All the webpages of a website are linked together. Websites that are 
created by individuals, organisations, and government. Whereas A webpage is the single page of information. 
It can contain various types of content like, text, images, videos, links, etc.

	 3.	� Hyperlink - A hyperlink is an image, graphic, or text on a webpage that, when clicked, opens another webpage, 
or takes you to some other place of the same web page. 

		�  Search Engine - A search engine is a website that searches the World Wide Web for information. You enter 
some keywords into the search bar of a search engine, it then displays a list of webpages that are related to the 
keywords entered by you. 

	 4.	 The Basic requirements for Internet Connection are as follow: 
i.	 A computer: A PC, smartphone, tablet, or a laptop for performing tasks. 
ii.	 A modem or Wi-Fi router: A device that is needed to connect your computer to the Internet. 
iii.	 An Internet Service Provider (ISP): A company that provides the Internet connection, such as BSNL, 

MTNL, Airtel, and Jio. 
iv.	 A web browser: A browser for surfing and accessing the Internet.

	 5.	 Components of Microsoft Edge are as Follow:
•	 Title Bar: It is the topmost bar on the window. It shows the tabs that are you are currently working on. It 

has the following buttons: 
	 ◦	 New Tab: It is used to open a new tab. 
	 ◦	 Minimize: It is used to minimize the browser window.
	 ◦	 Maximize: It is used to restore or maximize the browser window. 
	 ◦	 Close: It is used to close the browser window. 
•	 Back: The back button is used to go back to the previous page that you have already visited. 
•	 Forward: The forward button takes you to the page that was opened before clicking on the Back button. 
•	 Refresh button: It is used to reload the current webpage. 
•	 Home: It takes you to the home page of the browser window. 
•	 Address bar: The address bar shows the URL of the webpage or the website that you wish to open or that 

is already opened in Edge. 
•	 Search box: This text box is used to search for information. You can enter keywords here and press the 

Enter key to see the results. 
•	 Favorites: It contains bookmarked web pages, articles, or links for visiting later whenever you want. 
•	 Settings and more: It has various settings and other options. Some of these are: Favorites containing 

webpage or a website that you want to view later. 
	 ◦	 Reading List with the articles that you wish to read later. 
	 ◦	 History displays the list of all the websites that you have visited. 
	 ◦	 Downloads show the files that you have downloaded using the Internet. 

E.	 Application based questions.
	 Answer may vary from student to student.
F.	 Competency based questions.
	 Answer may vary from student to student.
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A.	 Tick the correct options.
	 1. b. Backdrop	 2. c. Fitness band	 3. c. Ctrl + D	 4. c. Sensing	 5. d. Facebook
B.	 Write T for true and F for false.
	 1. F		  2. F	 3. T	 4. T	 5. F
C.	 Define the following terms.
	 1.	� WWW - World Wide Web or commonly referred to as WWW, W3, or simply Web is interconnected system of 

webpages that are accessible through the Internet. The Web and the Internet are not the same.
	 2.	 URL - URL stands for Uniform Resource Locator. It is the unique address of a resource on the Web. 
		�  Each resource, whether it is an image, a video clip, or a web page, is assigned a unique address, which is its 

URL.  A URL generally has three parts—protocol, domain name, and path of the file on the server.
	 3.	� ISP - An Internet Service Provider (ISP) is a company that provides the Internet connection, such as BSNL, 

MTNL, Airtel, and Jio.
	 4.	� Homepage - A homepage is the first or front page of a website. It is the first page you see when you visit a 

website using a web browser.
	 5.	 Placeholder - It is the dotted rectangular box where you can add text, images, graphs, and so on.
	 6.	� Backdrop - Scratch allows you to change the backdrop of the stage. Similar to the sprite library, you can select 

a backdrop from the backdrop library or paint your own.
	 7.	� IoT - The Internet of Things (IoT) are the everyday objects or devices which connects to the Internet. All these 

devices work on the concept of voice recognition, or through the smartphone applications.  IoT is summarised 
as a system where different computing devices communicate with each other to share information and data 
using the Internet.

	 8.	� Coordinates - Scratch uses a coordinate system to determine the position of a Sprite. It uses two values—
X-position and Y-position. These values together form a coordinate. The X-position defines the horizontal 
position whereas the Y-position defines the vertical position of the Sprite.

D.	 Answer the following questions.
	 1.	 a)	� Deleting a Slide - If you feel that you do not need it anymore, you can delete it. To delete a slide, right-

click on the thumbnail of the slide, and then click on the Delete Slide option. 
Or 

			   Select the slide or slides that you wish to delete. Press the Delete key. 
		  b)	� Hide a Slide - When you do not need a slide for a specific presentation but might need it later, you can 

hide the slide instead of deleting it.
	 The steps to hide or unhide slides are as follows: 
	 i.	� Select the slide that to wish to hide. 
	 ii.	� Right-click on the slide thumbnail and click on the Hide Slide option. Similarly, you can also unhide 

a hidden slide.
	 2.	 The steps to do so are as follows: 

i.	 On the Home tab, in the Slides group, click on the New Slide down arrow and select Reuse Slides. 
ii.	 The Reuse Slides pane opens on the right. A list of a few suggestions appears. 
iii.	 Select the presentation that has slides that you want to use. The presentation is opened in the Reuse  

Slides pane.
iv.	 Select the position in the current presentation. 
v.	 Click on the slide you want to insert from the Reuse Slide pane. 
vi.	 Close the Reuse Slide pane.

Worksheet 2 Page 111Answers
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	 3.	� Sometimes it might be required to perform a task based on given conditions. This decision making is possible 
in Scratch using the Control blocks.

	 4.	� Traffic Monitoring - We use our mobile phones as sensors, which collect and share data from our vehicles 
through applications such as Google Maps.

		�  Energy Saving - Installing smart meter with sensor helps in monitoring the usage, reduce wastage, and ensure 
the efficient use of resources.

	 5. 
Web Browser Search Engine

1.	 A web browser is a software or an 
application program that is used to access 
information on the Internet.

1.	 A search engine is a website that searches 
the World Wide Web for information.

2.	 To open a website or a webpage, we type 
its URL on the address bar of the web 
browser and press the Enter key.

2.	 You enter some keywords into the search 
bar of a search engine, it then displays 
a list of webpages that are related to the 
keywords entered by you.

3.	 For example, Google Chrome, Apple 
Safari, Microsoft Edge, etc.

3.	 For example Google, Yahoo!, Bing, etc.

E.	 Label the different parts of PowerPoint window.

Quick Access Toolbar Title Bar Placeholder

Status Bar

Slide Pane

Slide Navigation Pane

F.	 What am I?
	 1.	 Sensing Block	 2. .pptx	 3. Smartwatch	 4. Favorites	 5. Rearranging Slides


